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Slots are variables, or the primary data storage containers on an object. In the Open Object dialog, the 
slots list shows all of the data that “resides” on the object. This includes both required input data, 
calculated output timeseries data, input tabular data, and input coefficients for the various physical 
process calculations. The list of slots may change depending on the User Methods that are selected.

The names of the slots are pre-defined in the object code for all objects except the Data Object, on 
which you can create and name your own slots. The list includes all slots which are currently “active;” 
i.e., associated with the object in general (for the selected controller) or associated with currently 
selected User Methods.

1. Slot Dialogs

To open a slot:

• in the Open Object Slots or Methods tab

- double-click on the slot’s row name
- right click on a slot’s row and use the Open Slot... context menu 
- highlight a slot’s row and select Slot p Open Slot from the command menu bar
- highlight a slot’s row and use the Ctrl-O accelerator

• from the main workspace, use the Workspace p Slots p Open Slot menu.

To close an Open Slot dialog, 

• select File p Close Window

• press Control-W when the window is active

• click on the red “X” button in the upper right corner of the dialog

• double click the white icon in the upper left corner of the dialog

• from the main workspace, use the Workspace p Slots p Close All Slots menu item to close all 
Open Slot dialogs.
RiverWare Technical Documentation: Slots
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1.1 Tour of the Open Slot Dialog

A sample Open Slot dialog for a series slot is 
shown to the right. Although other types of slots 
have different options, most of the slots have 
similar menus, look, and feel. This section first 
describes the general Open Slot layout and menu 
options. Then each individual type of slot is 
presented later with further information on type 
specific configuration options. 

The open slot contains the following:

• The title of the Open Slot dialog is the 
Object.Slot name. 

• The slot name is repeated in a text field below the 
menu bar. On data objects, the user can change 
the name of the slot by editing this text field. 

• The type of slot is displayed by an icon. Click 
HERE (Section 3) for a list of the icons. 

• The containing object’s icon is shown. Clicking on this icon will open the object. 

• The Value field shows the full precision of the highlighted cell and the units. The user can type a value 
directly in here or in the cell.

• The Description checkbox shows a text description of the slot. Click HERE (Section 1.3).

1.2 Menus

Following is a general description of the menus for the open slot dialog and how it is used. Detailed 
description of each type of slot is presented HERE (Section 3).

1.2.1 File Menu

The functionality available from the File menu depends on the slot type. In general, this menu is used 
to:

Import (fixed or resize) and Export (display or model precision):   Large sets of data may be 
imported into, and exported from the Open Slot dialog. Exported data are written to a text file in tab-
separated format. Imported data may be tab or space-separated. Exported values are written in the 
display units and either the precision currently specified in the Open Slot dialog (Display Precision) 
or the entire internal precision (Model Precision) Likewise, imported data are assumed to be in the 
same units as the Open Slot dialog. The entire precision of an imported value will be preserved, 
although only the selected display precision is shown. Import Fixed Size truncates incoming data if the 
data file contains more rows than the slot, and leaves existing data if the data file contains fewer rows 
than the slot. Import Resize automatically resizes the slot to match incoming data.

Object.Slot nameSlot name
Slot Type

Containing

Value

Object
(click to open)

Description
RiverWare Technical Documentation: Slots
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Plot:   Open a new plot with the given slot.

Print Expression:   On expression slots, print the expression.

SCT:   Add the series slot to an existing SCT or create a new SCT with the slot.

Show Workspace:   Bring the workspace to the top of the screen.

Close Window:   Close the window.

1.2.2 Edit Menu

The Edit menu is available on series, table, periodic and list slots and is used to change the number of 
rows or columns, and to change values in the slot. 

Cut/Copy/Paste:  There are options to cut/copy/paste data from the highlighted cells. These use an 
“internal” clipboard and cannot be copied or pasted from other applications. See the Export Copy and 
Import Paste options below to use the system clipboard.

Paste as Input:  Paste from the internal clipboard and set the Input flag.

Export Copy:  The Export Copy menu option is used to export the selected 
data to the operating system’s clipboard for use in other applications, like 
Excel. When the user clicks this option, an Export to Clipboard dialog 
opens as shown to the right. This dialog allows the user to choose the 
precision, either Display or Model, whether to Show NaN (or copy them as 
blanks) and whether to Include the Row Headers. It also provides 
information on the number of rows and columns that will be exported. 
Clicking Copy adds the selected data to the operating system’s clipboard 
while Cancel stops the operation.
RiverWare Technical Documentation: Slots
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Import Paste:   The Import Paste menu is used 
to paste data from the operating system’s 
clipboard into the slot. For example, the user can 
copy a selection of cells from Excel or a column 
of data from a text file and Import Paste it 
directly into the slot. After copying the data, the 
user selects one or more cells of the slot and then 
selects Import Paste. An Import from 
Clipboard dialog similar to the following is 
shown. This dialog displays the contents of the 
system clipboard and provides options and 
information on the paste operation. 

The contents of the clipboard will show pastable 
data (white) and un-pastable data (grey). Data is 
un-pastable if it does not fit in the content of the 
cell selection. For example, if the data in the 
clipboard has multiple columns and the cell is a single series slot, the second column of data is un-
pastable as shown in the above screenshot. 

Also, the user can choose to Limit paste operation to Slot Cell 
Selection using the check mark toggle. This limits the paste to only 
affect those cells in the slot that were selected. This selection is 
shown in the Slot Cell Selection line. For example, if only one cell 
in the slot is selected, but the clipboard contains two rows of data as 
above, all but the first cell are greyed out. In this example, shown to 
the right, only the value of 1 will be pasted. If the number of values 
in the clipboard is larger than slot selection, but the limiting 
operation is not checked, the paste will import all data and will add 
the necessary rows to the slot. Note, an import will not add columns 
to the slot.

Insert/Append/Delete:  The Edit menu contains options to Insert, 
Append, and/or Delete rows or columns from the slot, depending on 
the type and use of the slot. 

Clear All Outputs:   On series slots, this option can be used to clear all the Outputs. Note, all outputs 
are cleared at the beginning of a run.

Fill Values Below:  The Fill Values Below option is used to copy and paste the selected cell to all rows 
below. This will overwrite any existing data after the confirmation menu is clicked.

Replace NaN’s Below:  The Replace NaNs Below option is used to replace only NaN with the selected 
values. Any existing data will not be overwritten.

Summary of 
contents

Data in 

Slot Cell

Destination Slot

Limit toggle

clipboard

Pastable Data 
(white)

Un-pastable Data 
(grey)

Selection
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Interpolate:  The Interpolate option is used to interpolate between two known values within a column. 
It only works on a selection when the first and last value in the selection have values. The option will 
interpolate between the two values and change all the values to have the Input flag.

Slot Adjust Values:  One or more values selected in a slot 
can be adjusted using the “Adjust Values...” item available 
from the Edit menu of slot dialogs. When the user selects 
“Adjust Values...” RiverWare opens a modal Adjust Slot 
Values dialog which allows the user to provide the amount 
by which the selected slot values should be adjusted. 
Values may be adjusted by a percentage, or if all of the values have the same units, by a fixed increment 
in user units. After entering the adjustment value the user then applies that value to the selected values 
by selecting the “Ok” button or cancels the operation by selecting the “Cancel” button.

The adjustment is equal to adding a certain amount to the existing value(s) or multiplying by a 
percentage. The user may specify a positive or negative quantity. Note that the percentage option 
increases the existing amount by adding a specified percentage of that amount.

For example if the values 10.0 and 100.0 acre-ft/month are selected and the user enters 10 acre-ft/
month into the Adjust Slot Values Dialog and selects “Ok”, then the values will be changed to 20.0 and 
110.0. If the user enters 10%, the values will be changed to 11.0 and 110.0.

Note that it is easy to select all cells in a column by clicking on the header for that column.

Set Dimensions:  On some table slots the user can set both the number or rows and columns using this 
menu option.

1.2.3 Row Menu

On table and periodic slots, the Row menu is used to configure the rows.

Edit Row Labels:  Change the Row Label. All row labels can be configured at once in the dialog. The 
labels can also be set to object names using the Set Label(s) to an Object Name button. 

Insert Copied Rows:  Insert Copied Rows from the internal clipboard 

Insert New Row:  Insert a new row after the selected row

Append New Row:  Append a new row at the bottom.

Delete Rows:  Delete the selected rows

Delete Rows Below:  Delete all rows below the selected row
RiverWare Technical Documentation: Slots
Revised: 4/27/12
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1.2.4 Column Menu

On some table and periodic slots (such as on data objects), the user can add or delete columns to the 
table. The Column menu is used to do this and change column labels. 

Edit Column Labels:  Change the Column Label. All row labels can be configured at once in the 
dialog. The labels can also be set to object names using the Set Label(s) to an Object Name button.

Set Number of Columns:  Set the number of columns.

Append Column:  Add a column to the end.

Delete Column:  Delete the selected column

Delete Last Column:  Delete the last column

Set Dimensions:  Set the number of rows and column on the slot

1.2.5 View Menu - Slot Configuration Dialog

The view menu is used on all slot types to configure the slot. Following is a description of the general 
configuration menu. Detailed information is presented HERE (Section 3) for each slot type.

The Configure Object.Slot dialog is invoked by selecting 
View p Configuration in the Open Slot dialog. This dialog 
is used to change units and specify the precision and 
display format of the values in the slot. Depending on the 
type of slot opened, the dialog could appear a slightly 
different. For example, the portion of the dialog showing 
the Min Value and Max Value portion is only displayed for 
Series Slots. Note, to configure multiple slots at one time, 
use the Configure Existing Slots dialog described HERE 

(Section 2). 

Specifying Units:  RiverWare stores all slot values in 
RiverWare internal units and performs calculations in these 
units. When the object is first instantiated, the slots default 
to displaying the internal units, unless the Resource 
Database has been configured for a different default. The 
Resource Database file, riverwareDB, allows you to 
change the default display units to any unit of the specified 
unit type. More information on features and the syntax of the RiverWareDB file may be found in the 
reference section in the Units section of the documentation HERE (Units.pdf, Section 3).
RiverWare Technical Documentation: Slots
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The display units, or User Units, are user-selectable for each RiverWare slot and slot column. They may 
be changed at any time through the slot Configuration menu. When data are displayed in the Open Slot 
dialog, their values are converted from the internal RiverWare units in which they are calculated and 
stored, to User Units for display and export. When data is entered or imported, the values are 
interpreted by the slot as being in the User Units and are automatically converted to RiverWare internal 
units for internal storage. This means that you must change the User Units to match the units of 
incoming data BEFORE entering or importing data. For more information on units click HERE (Units.pdf, 

Section 1).

Setting Display Formats:  This section points out the importance of choosing meaningful and readable 
units for display configurations. The Unit Type is set internally by RiverWare. All other parameters are 
configurable. The Precision of the display corresponds to the number of digits displayed beyond the 
decimal place, not the number of significant digits. Although more than 15 significant digits may be 
displayed, such values are beyond the machine epsilon of RiverWare calculations, and are not reliable. 

Overriding Conversion:  Changing units through the Configure menu results in conversion of the 
displayed slot values. This behavior may be overridden by turning off (unchecking) the default Convert 
slot values to new User Units and Scale toggle. This allows the units and/or scale to be changed, 
without converting the display values. The display values are assumed to be in terms of whichever new 
units and scale are selected. This feature can be used to correct data which were accidentally imported 
or entered with the wrong display units selected. Great care should be exercised when using this 
feature, so as not to corrupt data. 

Note: Show Commas in Numbers - On slots, commas are shown by default as a thousands
separator. This is a global setting that is specified from the Workspace p Show Commas in
Numbers menu on the workspace. More information is provided HERE (Workspace.pdf, Section
5.7).
RiverWare Technical Documentation: Slots
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1.3 Slot Descriptions

On all slots, the user can specify a text description. The description 
is accessed from the View p Add/Show Description menu or the 
Description checkbox on the Open Slot dialog. When this option is 
selected, a panel is added that provides a text box in which the user 
can type the description. For a series slot, the dialog would then look 
similar to the following screenshot 

The Search Slot Descriptions 
utility can be used to find slots 
that have a description and/or 
slots that have a specific 
keyword(s) in their description. 
It is accessed from the 
RiverWare Workspace using the: 
Workspace p Slots p Find 
Descriptions... menu. The 
dialog shown to the right opens. 

In this dialog, you can:

• Find All Slots with Descrip-
tions - find any slot that has a 
description.

• Find Slots with Descriptions 
containing - find slots that 
have descriptions that contain 
the specified text. The search 
is not case sensitive.

You can limit the search to the specified types of slots including physical, account, supply or exchange 
slots. When any of the search input controls are changed, the Green Check icon turns into a Red “X”, 
and the search summary description is grayed out. Click the Search button to perform a new search.
RiverWare Technical Documentation: Slots
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This dialog has a Descriptions checkbox below the slot list. Turning on this checkbox replaces several 
slot attribute columns with a Descriptions column showing up to 150 characters of each Slot's 
description.

Turning on the Compress name columns checkbox replaces the distinct columns for object name, 
Account name and Slot name with a single “complete” slot name column.

Several context menu (right click) operations are available within the slot list:

• Open Slot -- Show the open slot dialog for the picked slot item.

• Open Object -- Show the open object dialog for the picked slot item (if applicable).

• Copy Slots -- Put the selected slot items into the slot clipboard, e.g. to paste into an output (manager) 
device slot list.

Buttons along the bottom of the dialog provide these functions:

• Open Slots: Separate open slot dialogs are shown for each of the selected items in the list. If more 
than four (4) slots are selected, then a query dialog box is shown confirming the operation with a mes-
sage like this: “Do you want to show 421 Open Slot dialogs?”. Note that all shown open slot dialogs 
may be hidden with the Workspace p Slots p Close All Slots... menu operation.

• Show All Slots in SCT: All slots in the list (regardless of item selection) are shown in a new SCT dia-
log, and the dialog is closed.

• Show Selected Slots in SCT: Selected slots in the slot list are shown in a new SCT dialog, and the 
dialog is closed.

• Cancel: The dialog is closed.

The dialog can also be used to find input values on series slots as described HERE (Section 3.1.4).

1.3.1 Adjust Menu

The Adjust menu, available on series and table slots, is used to change the display size of the columns 
in the slot. Users can manually resize columns by dragging the dividers between the column headers. 
The following five operations are also available in the View menu:

• Set Column Widths: set all data columns to the width of the single selected column.

• Grow Columns to Fit Data: expand (but don’t shrink) the columns to fit the widest numeric value dis-
played in the corresponding columns.

• Fit Columns to Data: resize all of the data columns to fit the widest numeric value displayed in the 
corresponding columns.

• Fit Columns to Headers and Data: resizes all of the data columns to fit the larger of the text in the 
corresponding column headers or the widest numeric value displayed in the corresponding columns.

• Fit Columns to Headers: resizes all of the data columns to fit the text in the corresponding column 
headers.
RiverWare Technical Documentation: Slots
Revised: 4/27/12



10
 

Slot Dialogs
Creating and Configuring Slots on Data Objects

10
1.4 Creating and Configuring Slots on Data Objects

Data Objects are empty when first created. They are populated with slots based on user needs. The user 
can create various types of series, tables, periodic tables, statistical tables, scalar and expression slots. 
Click HERE (Section 3) to view a description of each type of slot. The user is NOT able to create Multi 
Slots, Table Series Slots or List Slots on Data Objects.

The main menu bar on the Open Object dialog for the Data Object has a pull-down Slot menu (or in 
the context-sensitive menu activated by right-clicking in the slot list area of the data object) which 
contains commands to: 

• Add Series Slot
• Add Series Slot with Expression
• Add Integer Indexed Series Slots
• Add AggSeries Slot
• Add Integer Indexed AggSeries Slot
• Add Table Slot
• Add Statistical Table Slot
• Add Periodic Slot, Text Headers
• Add Periodic Slot, Numeric Headers
• Add Scalar Slot
• Add Scalar Slot with Expression
• Add Mass Balance Summary (HERE (Section 3.13.1))

There are also commands to 

• Delete Slot
• Copy Slot
• Paste Slot
• Open Slot
• Plot Slot
• Links to Slot

After the slot is created, the following steps should be taken:

1. Open the newly created slot.

2. Rename the slot by typing directly in the Name field.

3. Use the configure menu option (and the subsequent dialog) to set the units, display format, and 
convergence criteria.

4. On series, consider revising the time series range, if necessary, prior to adding data into the 
series. On table slots, consider setting the number of rows and columns and changing the row or 
column labels. 
RiverWare Technical Documentation: Slots
Revised: 4/27/12
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2. Global Slot Configuration

The Configure Existing Slots dialog enables multiple slots to be configured at the same time. The slots 
available do not include accounting slots as accounting slots are configured from the Accounting 
System Configuration. To access the Configure Existing Slots dialog, click the Workspace  Slots  
Configure Slots menu item from the main workspace dialog in RiverWare. The dialog is used in the 
following general sequence as described in the following sections:

• Add slots to the list

• Select a new user unit, scale, min value, max value, display format, or convergence. Or, change the 
unit type and user units on data object slots. 

• Select one or more of the slots from the list

• Apply the changes to all or selected slots. 

Changes are immediate and are reflected in the dialog. Changes only apply to relevant slots, e.g. 
changes to flow user units only apply to slots that have Flow as the unit type. Below is a screenshot of 
the dialog with the main areas noted.
RiverWare Technical Documentation: Slots
Revised: 4/27/12
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2.1 Selecting Slots

To select the slots for which you wish to make changes, you must add them to this dialog. To do this, 
click the Add Slots button or use the corresponding context menu item available with a right mouse 
click in the slot list. This opens RiverWare’s slot selector. Click HERE (Selector.pdf, Section 3) for more 
information on using the selector. The Selector can be used to add all or a subset of the existing non-
accounting slots in the current model. 

After making a selection of one or more slots, those slots are added to the list view area of the dialog. 
These slots, or a subset, are the slots you wish to modify. Note that if a slot has multiple columns that 
can be configured independently, an entry is created in the list view for each column (see the example 
Elevation Volume Table Slot in the screenshot below). For tables, like the Periodic Slot, where data in 
any column must have the same units, only one list view item is created for this configuration. Periodic 
slots that have a second units dimension in the numeric headers of the columns get a second list view 
item to allow configuration of this dimension (see the Operating Level Table example slot). If some 

Add or remove 
slots from the list

Slot list 

Change display 
format 

Change user 

Change unit type for slots on Data Objects 

Change convergence

units 

Apply to all slots in list Apply only to highlighted slots in list
RiverWare Technical Documentation: Slots
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configuration item, like convergence, is not applicable to an item, that column is left blank in the list 
view display. 

To remove specific slots from the dialog, first select them. Note that the label above the list view 
indicates the number of items selected and the total number in the list. Then click the Remove 
Selected Slots button or use the corresponding context menu item available with a right mouse click in 
the slot list view. All slots can be removed using the Remove All Slots button or its corresponding 
context menu item. Double clicking an item in the slot’s list view will bring up the Open Slot dialog for 
that slot.

2.2 Configuration Options

The configuration frame at the bottom of the dialog has check boxes for four types of configuration 
items; User Units, Display Format, Convergence, and Unit Type for Slots on Data Objects. By 
checking or unchecking these, any combination of the configuration options can be used. For example, 
if only convergence values are to be altered, only its check box can be selected, meaning that user units, 
unit type, and display format will not be modified by any applied changes.
RiverWare Technical Documentation: Slots
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Specifying User Units, Display Format, and Convergence:  The items available for configuration 
appear much as they do in the configuration dialog for a single slot as described HERE (Section 1.2.5). 

To change user units, click the User Units check box. The For Unit Type pull down menu is used to 
specify for which unit type the user units will be modified. The new user units are specified in the User 
Units pull down menu. Specify a new Scale, Min Value, or Max Value and indicate whether to convert 
existing values to the new. To change the display format, click the Display Format check box and 
specify the new value. To change convergence, click the Convergence check box and enter a new 
value. Note, if any of the pull down menus or text boxes (User Units, Scale, Min Value, Max Value, 
displayType, convergence Type, or convergence Value) are left blank when these configurations are 
applied, no changes will be made to any slots for these items.

Specifying a new Unit Type on Data Objects:  To change the unit type of a slot on a data object, click 
the Unit Type for Slots on Data Objects check box and specify an old unit type and the new unit type 
and user units. These changes only apply to slots on data objects as the user is not allowed to ever 
change the unit type of a slot on a simulation object.

Note: Show Commas in Numbers - In slot values, commas are shown by default as a
thousands separator. This is a global setting that is specified from the Workspace Show
Commas in Numbers menu on the workspace. More information is provided HERE
(Workspace.pdf, Section 5.7).

2.3 Applying the changes

When all desired configuration changes have been made, they can be applied in two ways, Apply to 
Selected or Apply to All. To apply changes only to selected items in the slot’s list view, click the Apply 
To Selected button at the center bottom of the dialog. Note that the desired items should be selected 
before entering the configuration information because changing selections clears the configurations. 
This will change only those slots highlighted in the list view. Configuration changes can be applied to 
all slots in the slot list, whether selected or not, by clicking the Apply To All button at the left bottom of 
the dialog. 

If changes are applied to a slot where they are not applicable, the changes will be ignored for that slot. 
For example, if convergence is configured to be changed and is applied to a slot that does not have 
convergence, it will be ignored. Similarly, if the user unit for flow is configured to be changed and a 
slot has a unit type of length, the user unit change will be ignored if applied to that slot.

2.4 Use Examples

Following are two examples of using the Configure Existing Slots.

Forgotten riverwareDB file:  You just spent the last two hours building a model of a basin only to 
realize that you didn’t have a riverwareDB file in place to give you the correct default units. Use the 
Configure Existing Slots dialog to change all of these slots using the following steps
RiverWare Technical Documentation: Slots
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• Open the dialog. From the main workspace, use the Workspace  Slots  Configure Slots menu.

• Select all slots in the model. Click the Add Slots button. In the selector, click All object types, All 
objects, All to select all slots and click OK. When finished processing, the list view in the Configure 
Existing Slots dialog should now have all of the slots in the model. 

• Click the toggle to specify that you wish to change User Units. 

• For one unit type in your model, select that unit type from the For Unit Type box, enter a new user unit 
and/or scale. Click the Apply to All button. Repeat for all unit types in your model.

• Change display format or convergence in a similar manner as desired

Changing configuration on specific slots:  In this example, we have decided that for debugging 
purposes, we need all of the flow slots on specific reservoirs to be in acre-feet/day. There are two 
approaches we can use with the Configure Existing Slots dialog to make these changes. 

• Add only the Reservoir flow slots to the list view using the slot selector to select the correct slots. A 
Unit Type filter can be applied in the selector to filter out non-flow slots. In the Configure Existing 
Slots dialog, we would then Apply to All to commit the changes. 

• Add all of the reservoir slots to the listview. We would then highlight only the desired slots and make 
the desired changes. Then we would use the Apply To Selected button to make the changes. 

Using the selector to choose the appropriate slots is more powerful and more elegant but you don’t see 
the slots’ configuration values before you make the selection. Selecting all slots, then choosing the 
desired slots in the list view allows you to see all of those slots’ configuration before you modify them. 
For example, you see that reservoir Diversion slots (linked to a water treatment plant) have units set to 
“mgd” while all the others are set to “cfs”. You may wish to change all the slots to acre-feet/day except 
the one with configured to be “mgd”. 
RiverWare Technical Documentation: Slots
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3. Types of Slots

This section presents a brief description of the different types of slots and how they are used for 
representing different types of data. Click on the link to go to the section that further describes how to 
view, create, and edit that type of slot.

Name Icon Type Description

Series Slot
  Go to Section 3.1

Series

A single timeseries of values. These slots may be linked with 
other Series Slot. Input data in Series Slots controls the 
simulation solution, and all simulation output data are written 
to Series Slots. For these reasons, Series Slots contain special 
functionality not found in table slots. Series Slots on a Data 
Object can be linked to any linkable slot on the workspace. 

Series Slot with 
Expression
  Go to Section 3.5

Series

A specialized Series Slot whose value is computed from a 
user-defined arithmetic expression possibly containing other 
slot names as variables. They are used to calculate quantities 
such as “combined Storage of all Reservoirs.” Expression slots 
are available on Data objects and both Series slots and Scalar 
slots may contain expressions.

Integer Indexed 
Series Slot
  Go to Section 3.4

Series
A specialized series slot that is indexed by an integer number 
instead of a date.

Agg Series Slot
  Go to Section 3.2

Series
A specialized Series Slot that is an aggregation of one or more 
Series Slots which are independent of one another. They are 
used to group together similar series of data.

Integer Indexed 
Agg Series Slot
  Go to Section 3.4

Series
An agg series slot that is indexed by an integer number instead 
of a date.

Multi-Slot
  Go to Section 3.3

Series

A specialized Series Slot aggregating one or more Series Slots. 
The value in the first Series Slot column is the sum of the 
values in all of the other Series Slot columns (other slots to 
which they are linked). New Series Slot columns are 
automatically added when a link is made to the MultiSlot.
RiverWare Technical Documentation: Slots
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Table Slot
  Go to Section 3.6

Table

A two or three-dimensional table of values for representing 
one or more functional relationships. Each column stores a 
variable with its own unit type and name. Rows are numbered 
beginning with 0. Both rows and columns can be referenced 
by using an index (0, 1, 2 . . . n) or using a label string.

For a three-dimensional table lookup to be successful, column 
1 must contain blocks of equal values which increase down the 
table, and column 2 must contain monotonically increasing 
values within each block of values from column 1. A two-
dimensional table only requires monotonically increasing 
values in its first column.

Table functionality includes accessing values beginning with 
the table indexes and accessing a column index beginning with 
row index and table value.

Table Series Slot
  Go to Section 3.7

Table

A specialized table slot whose rows correspond to time values. 
This slot contains limited timeseries functionality thus making 
it more efficient than Series Slots. It is commonly used for 
writing and reading large amounts of data. It is primarily used 
within object user methods; the user cannot create them on 
Data Objects.

Statistical Table 
Slot
  Go to Section 3.8

Table

A specialized table slot allowing the user to specify a 
statistical function, such as flow duration curve, which is 
computed at the end of a run using the data in specified model 
slot(s). This statistical analysis data can then be plotted or 
exported.

Periodic Slot
  Go to Section 3.9

Table

A specialized table slot, the periodic slot is used to hold data 
that repeats over a specified time period. For example, a set of 
monthly evaporation coefficients for a reservoir (the same 
every year), could be held in a periodic slot. The timeseries 
associated with the data can vary (hourly, daily, monthly, etc.) 
as well as the period over which the data repeats. The periodic 
slot can also handle irregular timeseries and can have either 
text or numeric column headings.

Scalar Slot
  Go to Section 3.10

Scalar
The scalar slot is used to hold a single piece of numeric data 
that will not vary with time. The scalar slot is a one-row, one-
column table slot.

Name Icon Type Description
RiverWare Technical Documentation: Slots
Revised: 4/27/12



18
 

Types of Slots

18
Scalar Slot with 
Expression
  Go to Section 3.11

Scalar
A scalar slot whose value is computed from a user-defined 
arithmetic expression. The expression can contain values from 
other slots as variables. This slot resides on a Data Object only.

List Slot
  Go to Section 3.12

List
The list slot is used in certain user methods to specify a list of 
objects or slots associated with that method. The user cannot 
add List Slots to data objects

Mass Balance 
Summary
  Go to Section 3.13

Mass 
Balance 
Summary

The mass balance summary slot is a user-defined hierarchy of 
series slot collections used to check mass balance across many 
objects. This slot resides on a Data Object only.

Name Icon Type Description
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3.1 Series Slot

There are several types of time series slots with 
various column configurations. Since all of 
these slot types contain rows which correspond 
to the series of data, they will be referred to 
collectively as series slots. Shown is a series 
slot with the key areas highlighted. There is a 
datetime spinner and scroll button used to 
scroll to the given date. Icon/buttons are used 
to show display compression, show notes, and 
to Plot the slot. The datetimes are shown as the 
row headings, the data values are shown in the 
cells, and each cell’s value has a flag. Bold, 
green separators are automatically created 
based on the timestep of the slot. For example, 
in a daily slot, separators are placed between 
months. In 6-hour slot, days are separated. 
Also, there is a blue divider between the initial 
and start timestep. There is a red divider after 
the finish timestep.

Data:  Time series data are displayed with one 
value per row where each row represents a 
timestep. A scroll bar along the right side of the 
field is used to view the entire set of data. Each 
row contains the full date and time, a status 
flag, and the slot value at that time. A slot value 
which shows NaN (Not a Number) represents 
an unsolved variable. 

All RiverWare calculations are performed in 
internal RiverWare units. These are generally 
SI units such as: grams, meters, cms, hours, 
degrees Celsius, joules, megawatts, etc. The 
values which appear in the Open Slot dialog, however, may be displayed in one of various user-selectable 
units. The selected User Units: for a slot are indicated directly above the scrollable field. Simulation 
Output values are automatically converted to the User Units before being displayed in the Open Slot 

Scroll 
Display Plot

FlagDatetimes Data

Compressionto date slotNotes

Selection
Info

Priority

Start
Timestep
Divider 

Time
Interval
Divider

Finish
Timestep
Divider

Description
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dialog. Likewise, INPUT values which are entered and displayed in User Units are internally converted 
to RiverWare units for simulation calculations. This topic is covered in more detail HERE (Units.pdf, 

Section 1).

Timesteps:  Timesteps are reported chronologically. If the series is an Integer Indexed series, the rows 
are indexed by an integer number instead of a timestep.

Editing Slot Values:  Conventional editing commands are available for all slots. They allow cutting, 
pasting, filling and clearing of data.

A Delete or Cut of any timestep except the first shifts data up to replace the lost cell, reassigning values 
to new timesteps. A Delete or Cut of the first timestep removes it completely from the series, 
essentially shifting the start date of the series. 

Similarly, Insert New Cell or Insert Copied Cells when the first timestep is selected adds a new 
timestep to the beginning of the series. When any other timestep is selected, Insert New Cell or Insert 
Copied Cells shifts data down from the added cell, reassigning values to new timesteps.

Priority:  In a Rulebased Simulation run, the dialog shows the priority of the slot at the given timestep. 
This can enable/disabled using the View p Show Priorities menu.

Selection Info Area:  Optionally, the Selection Info Area (also called the Summary Area or Selection 
Statistics) can be shown using the View p Show Selection Statistics. This displays information on 
the selected cells in the Slot including the name or number of slots and then statistics on the selection. 
Statistics include Sum, Average, Median, Min, Max, Range, and Difference. All, some or none of these 
may be shown depending on the number of cells selected and the units of those cells. If a single value is 
selected and that value was solved for or set as a result of a rule in rulebased simulation, the Priority is 
also shown.

Global Time Scroll:  The Open Slot dialog allows the concept of context sensitive right-mouse 
functions. One menu option is the Global Time Scroll which allows the user to move all dates in the 
model to the selected date. Any dialog that is open will move to that date. Any dialogs that are opened 
will open to that date.

3.1.1 Configuration

Following are configuration options specific to Series Slots. Further information on general 
configuration can be found HERE (Section 1.2.5).
RiverWare Technical Documentation: Slots
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:

 

Setting Min/Max on a Series Slot:  series slots have 
minimum and maximum values which can be entered through 
the View p Configure dialog. In general these values are not 
used by the simulation. However, there are a few cases where 
a value can be used by the Object’s User Methods. For 
example, a minimum Outflow on a Reach object is used to 
calculate the maximum allowable diversion. If no value is 
input, the total Inflow may be diverted.

On all series slots, if the simulation calculates a value or a 
value is INPUT which violates the specified minimum or 
maximum, a warning is issued in the diagnostics window, but 
the simulation continues.

Setting Convergence and Max Iterations:  Series slots have 
Convergence settings which can be edited in the lower 
portion of the Configure dialog. A slot can be reset if the new 
value is not within convergence of the old value and it has not 
been set more than the maximum number of times. The Set 
Value functionality is described HERE (Simulation.pdf, Section 4.1).   The following table describes the 
available convergence criteria: 

Type Units Description Convergence is 
reached: Examples:

None NA
No convergence. Any new value 
is considered different than the 
old value. 

Example of non-convergence
old = 100.0 cms
new = 100.001 cms

Absolute
Internal 
(m, cms, 
m3, etc)

Absolute difference in internal 
units. The user enters the value 
in internal units. If old minus new 
(in internal units) is less than or 
equal to the convergence value, 
it is considered converged. 

if

Example of convergence:
old = 100.0 cms
new = 100.001 cms
value entered = 0.001 cms

Example of convergence
old = 100.0 cfs
new = 100.01 cfs
value entered = 0.001 cms
why?
100 cfs = 2.83168 cms
100.01 cfs = 2.83197 cms 
2.83168 - 2.83197 = -0.00029
0.00029 < 0.001

MIN/MAX

Convergence

Never

old new– value≤
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Time Series Range--Series Slot:  The default start times and 
timestep are inherited from the Run Control settings when the 
object is instantiated. All series slots are initialized with one 
timestep to minimize model file size. Other rows are added by 
the user as needed for input or appended at run time when the 
slot’s output values are calculated. You may change the time 
series range directly through the Time Series Range Dialog.

On Integer Indexed Series, the user is able to change the 
number of Values but the start, end, and timestep size 
configuration areas are disabled. 

The time series range and timesteps can also be changed by selecting Synch With Run Control in the 
Time Series Range Dialog. This will update the time series range in the slot to match the time series range 
set in the Run Control dialog. The default start times and timestep are inherited from the Run Control 
settings when the object is instantiated. All series slots are initialized with one time.

Percent NA

Percent difference. The user 
enters the value as a 
percentage. If old minus new 
divided by the old value is less 
than or equal to the convergence 
value divided by 100, it is 
considered converged.

If both old and new are zero, it is 
considered converged if old 
minus new is less than 1.1E-12

if

 or 
If old or new is 0.0, then 
convergence is 
reached if

 

Example of convergence:
old = 100.0 cms
new = 100.001 cms
value entered = 0.001

Example of non-convergence
old = 10.0 cfs
new = 10.01 cfs
value entered = 0.001
why?

Unit 
Percent

User 
Units 
specified 
for the 
slot

Absolute difference in user units. 
The user enters the value as a 
percentage in the specified user 
units, without considering scale. 
If old minus new (in user units) is 
less than or equal to the 
convergence value (in user 
units) divided by 100, it is 
considered converged.

if

Example of convergence:
old = 100.0 cfs
new = 100.001 cfs
value entered = 0.1 %, cfs

Example of non-convergence
old = 10.0 cfs
new = 10.1 cfs
value entered = 0.1 %, cfs
why?

Type Units Description Convergence is 
reached: Examples:

old new–
old

--------------------------- value
100

--------------≤

old new–
1.1X10 12–

≤ 10 10.01–
10

---------------------------- 0.001
100

------------->

old new–
value
100

--------------≤

10 10.1–
0.1
100
--------->
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Show Linked Slots:  In the View menu, there is an option to Show Linked Slots. When selected, this 
shows all of the slots to which the given slot is linked.

Show Notes Column and Notes Group menu:  The Show Notes Column and the Notes Group menu 
are used to display Notes that are associated with a timestep on a series slot. For more information on 
Notes on Series Slots, see the documentation HERE (Section 5).

3.1.2 Series Display Compression

The Series Display Compression utility allows the user to “compress” or hide a particular value, NaNs, 
both, or any repeated values. This utility is useful for slots that hold data that is often the same value 
and the user only wishes to see any changes to this standard value. The functionality is available on 
Series Slots, Agg Series Slots, Multi Slots, and Table Series Slots.

3.1.2.1 Accessing Series Display Compression

Series Display compression can be accessed from

• the Open Slot dialog’s View p Series Display Compression 
menu

• the Series Display Compression icon  on the Open Slot dialog

When either of these options are chosen, the Open Slot dialog adds 
the display compression area between the scroll area and above the 
column heading as shown.

3.1.2.2 Configuring Compression

Following is a screenshot showing all of the configuration controls. 
Each option is then described in detail.

Enable/Disable Toggle:  When Series Display Compression is first activated, there is a check mark 
in the toggle indicating that it is active. This toggle is used to toggle the compression on and off. Thus, 
the user can configure compression, then toggle it off to view or edit all the values, and then toggle it 
back on to re-enable compression

Enable/Disable Toggle

Compression Mode Show/Hide

Set Reference Value Precision Type

Status

Extended Controls
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Compression Mode pull-down menu:  When first activated, the Compress Repeated Values option 
is selected by default in the pull-down Compression Mode menu. The modes listed below are 
available for display compression:

• Compress Repeated Values: Any values that are repeated will be com-
pressed into one row. When this option is selected, the repeated values are 
all compressed into one cell and a count (Cnt) column is added. A small 
triangle is added to the lower corner of the cell to indicate that the cell 
represents repeated values. In the screenshot 3 values of 55cfs are 
repeated on 1/1/1996. These represent 1/1 through 1/3/1996.   

• Hide NaN Values: All NaN values will be hidden and a dotted 
line is shown. For example, NaNs are hidden for 1/4 through 1/7/
1996. 

• Hide Value: #: All values matching the reference value will be 
hidden and a dotted line is shown. The user can change the value 
by clicking on the Reference Value icon  and entering a new value.

• Hide NaNs and Value: #: All NaN values or values matching the reference value will be hidden and a 
dotted line will be shown. The user can change the reference value by clicking on the Reference Value 
icon  and entering a new value.

• Show Value: #: All values that match the reference value are shown. NaNs are hidden. The user can 
change the reference value by clicking on the Reference Value icon  and entering a new value.

• Show NaNs and Value: #: All NaNs and values that match the reference value are shown. The user 
can change the reference value by clicking on the Reference Value icon  and entering a new value.

• Show Values <= #: All values less than or equal to the reference value are shown. NaNs are hidden. 
The user can change the reference value by clicking on the Reference Value icon  and entering a 
new value

• Show Values >= # :All values greater than or equal to the reference value are shown. NaNs are hid-
den. The user can change the reference value by clicking on the Reference Value icon  and entering 
a new value

Note: The above text describes the options and how RiverWare 
represents each option on the screen. In each case, if the 
compressed/hidden range contains the automatic green datetime 
interval delineations (e.g. Monthly lines on a daily slot) those green 
lines will still be shown. In the example to the right, two green lines 
are shown representing the delineation before Feb. 1 and March 1 
in this daily slot.

Triangle indicates compressed cells

Count Column

Dotted line indicates hidden cells
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Show/Hide Extended Controls:  To the right of the Compression Mode pull-down menu, the Show/

Hide Extended Controls button  can be used to further refine how the compression is configured. 
When this button is clicked a further set of configuration options is presented and the arrow now points 
down.

Set Reference Value:  When any of the “Hide Value” or “Show Value” compression modes are 

selected, the Set Reference Value icon  become active. Clicking this icon opens a dialog to allow 
the user to enter a value. This is the value that will be hidden. Once a new number is entered, the 
Compression Mode menu options will display that number in the menu.

Precision Type pull-down menu:  Each of the above compression modes compares a value in a cell to 
some other value, either a reference value, NaN or the previous timestep’s value. For more flexibility, 
value comparison can be based on either:

• Display: The display precision will be used; this is the default. If two numbers 
appear the same on the screen, they are considered the same.

• Convergence: The slot’s convergence value will be used to compare the numbers. 
A number must be within convergence of the other number to be considered the 
same.

• Exact: The internally stored numbers will be compared.

Status information:  The Status information will show the number of rows that are hidden or 
compressed.

3.1.2.3 Editing Compress/Hidden Values

On the Open Slot dialogs, the user can highlight a number of cells and type a new value that will be 
entered, as Input, into each selected cells. When Series Display Compression is enabled, the editing 
of values is treated a differently as follows:

Compressed Repeated Values:  If the Compress Repeated Values is selected, editing of selected 
cells will edit any compressed cells. For example, if repeated 33 values are repeated and the user selects 
the repeated value, types in a new number, all 33 values will be set to that new number.

Hidden NaNs or Value:  If any of the “Hide” options are selected, editing of selected cells will not 
affect hidden cells. Hidden values and NaN’s will not be overwritten. But, any cells displayed and 
selected will be affected by the new value. Also, if the entire column is selected, edits will then apply to 
all values, whether hidden or not.
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3.1.2.4 Multi-Column slots

On multi-column slots, (Agg Series, Multi Slots, Table Series Slots, and accounting slots), the Series 
Display Compression will only compress/hide a row if the compression is valid on all columns of the 
row. Following is a screenshot where the repeated value compression only applies to a subset of rows: 

Notice that only rows 1/3-1/6 and 1/7-1/10 are compressed because the repetition occurs across all 
columns. Similarly, on multi-column slots, if the user chooses to “Hide NaNs and Value”, it will only 
hide a row if all three columns have the reference value OR NaN.

3.1.3 Timestep I/O menu - Flags

On Series Slots, the Timestep I/O menu is used to change the status of the cell’s value by changing the 
flag. Possible flags vary by slot, but may include: 

- INPUT (I), 
- OUTPUT(O), 
- DMI INPUT (Z), 
- ITERATIVE MRM (i),
- TARGET BEGIN (TB or tb), 
- TARGET (T), 
- BEST EFFICIENCY (B), 
- MAX CAPACITY (M), 
- DRIFT (D), 
- SURCHARGE RELEASE (S), 
- REGULATION DISCHARGE (G),
- UNIT VALUES(U), and 
- RULE (R). 

User-input data are automatically flagged as INPUT, and may not be overwritten by simulation results. 
Certain values imported by an input DMI are flagged Z for DMI INPUT and are treated identically to 
INPUT (I) flags. Initialization Rules can also set values with the Z flag. OUTPUT (O) timesteps may 
contain values calculated during a previous run or toggled from INPUT status. These values are 
automatically cleared to NaN at the beginning of a simulation run. This guarantees that no previous 
solutions remain from one run to the next. Simulation results are written to timesteps flagged as 

Repeated Value Compression toggled Off

Repeated Value Compression toggled On
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OUTPUT, TARGET BEGIN, BEST EFFICIENCY, MAX CAPACITY, SURCHARGE RELEASE, 
DRIFT and UNIT VALUES. Flags other than OUTPUT and INPUT are only available for certain series 
slots. 

This section describes the use of special flags which may be set on SeriesSlot timesteps. The flags are 
typically set by the same mechanisms as INPUT and OUTPUT flags. But, unlike INPUT and OUTPUT 
flags, each type of special flag is only applicable to one or two slots. All SeriesSlots must have one of 
the following flags set for every timestep; each flag is indicated by its abbreviation:

• General flags available to all SeriesSlots.

- I for INPUT
- O for OUTPUT
- Z for DMI INPUT - This flag indicates that the value was set by an input DMI. Click HERE (DMI.pdf, 

Section 2.4) for more information. In simulation, this flag behaves identically to the INPUT (I) 
flag.

- R for SET BY RULE - This flag indicates that the value was set directly by a rule.
- i for ITERATIVE MRM - This flag indicates that the value was set during iterative MRM by an 

MRM rule. Values with the “i” flag can be overwritten as though it is a “O” flag. Values with the 
“i” flag are cleared at the beginning of a single run and at the start of an MRM run, but are not 
cleared between each iterative MRM run. They are considered input during an iterative MRM 
run.

• Power calculation flags available to Energy slots.

- B for BEST EFFICIENCY
- M for MAX CAPACITY

• Maximum Outflow flag available to Outflow slots

- M for MAX CAPACITY

• Target flags available to Storage and Pool Elevation slots.

- TB or tb for TARGET BEGIN
- T for TARGET

• Drift flag available to Regulated Spill and Bypass slots.

- D for DRIFT

• Surcharge Release flag available to the Surcharge Release slot

- S for SURCHARGE RELEASE

• Regulation Discharge flag available to the Regulation Discharge slot

- G for REGULATION DISCHARGE

• Unit Values flag available to Turbine Release and Energy slots on power reservoirs with the Unit 
Power method selected:

- U for UNIT VALUES
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3.1.3.1 Setting Flags

Flags are set from the Open Slot dialog (or from the SCT). In the 
Open Slot dialog, a flag is set on the highlighted timestep by 
selecting the flag from the Timestep I/O menu. Flags which are 
unavailable for that slot will appear grayed-out in the menu. 

The Timestep I/O menu has options to:

• Set to Input: Set selected cells to Input

• Set All to Input: Set all cells to Input

• Set to Output: Set selected cells to Output

• Set All to Output: Set all cells to Output

• Reverse Input/Output: Reverse the input and output flags on 
selected cells

• Reverse Input/Output All: Reverse the input and output flags on 
all the cells

• Set one of the special flags on the selected cells. The following sections describe many of the special 
flags.

3.1.3.2 Power Calculation Flags on Energy

BEST EFFICIENCY and MAX CAPACITY flags may be set on Energy timesteps instead of an INPUT 
Energy request value. These flags are used by the getPlantPowerRelease User Method to calculate the 
most efficient or maximum Energy generation possible for the flagged timestep. 

The getPlantPowerRelease method uses tables to relate the current Operating Head to the most 
efficient Turbine Release or maximum allowable Turbine Release. The MAX CAPACITY flag is 
available for all power method except LCR Power Calc. The BEST EFFICIENCY flag is only valid for 
the following power methods:

• Plant Power Calc

• Plant Efficiency Curve

• Plant Power Equation

• LCR Power Calc

• Unit Power

The calculation of the best efficiency Energy generation or max possible Energy generation is an 
iterative solution. The Outflow required to produce the desired type of Energy affects Tailwater 
Elevation, which affects Operating Head, which affects the Outflow required to produce the desired 
Energy. For more information on these methods, click HERE (Objects.pdf, Section 16.1.2).

When an energy value has been calculated using a MAX CAPACITY or BEST EFFICIENCY flag and it is 
set as a user input for a subsequent run, a warning may be posted that says “Energy request cannot be 
met on current iteration.” This is due to the way RiverWare solves. When two reservoirs are modeled in 
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series, the Tailwater Elevation of the lower reservoir affects the Operating Head of the upper reservoir. 
The Outflow of the upper reservoir, in turn, affects the Tailwater Elevation of the lower reservoir. This 
creates an iterative loop between the Outflow from the upper reservoir, the Tailwater Elevation of the 
lower reservoir, and the Operating Head of the upper reservoir. When an Energy value is set using 
either a MAX CAPACITY or a BEST EFFICIENCY flag, the reservoirs iterate over Outflow, Tailwater 
Elevation, and Operating Head until the values converge. If the Energy value is now set as an input and 
the model is run again, the Input Energy may not be possible given the Operating Head on the first 
iteration. If this happens a RiverWare warning is posted but the run does not abort, since the energy 
value MAY match the Operating Head at a later iteration. The Energy also MAY NOT match the 
Operating Head at a later iteration. If this occurs, the model will continue running even though the 
object did not solve. The run will NOT be aborted, but objects may not dispatch because required 
information was not propagated to them. The user must check the dispatch dialog if they receive the 
RiverWare warning message given above to make sure the model ran correctly.

3.1.3.3 Maximum Capacity Flag on Outflow

As demonstrated in the simulation exercise, this flag computes the maximum possible Outflow from a 
Reservoir on a given timestep. Setting the MAX CAPACITY flag on a Reservoir Outflow slot forces the 
Outflow to equal the sum of the maximum (Turbine) Release and the maximum Spill. This flag should 
be used with great care, as its effects may cause downstream reservoirs to exceed their operating 
ranges. The use of this flag also depends on having reliable and accurate input tables relating elevation 
to maximum release and spill. 

The MAX CAPACITY flag is set by highlighting a simulation timestep on the Outflow slot of a 
Reservoir and selecting Timestep I/O p Max Capacity. RiverWare places an M at the selected timestep 
to indicate that the flag is active. This flag is treated as an INPUT, but does not require a value. If a 
valid Outflow value is present at the flagged timestep, it is ignored in the simulation; a new Outflow 
value is calculated and displayed at that timestep. This behavior is similar to the Max Capacity and Best 
Efficiency flags of the Energy slot and the Drift flags of the Regulated Spill and Bypass slots. A 
Reservoir which has the Outflow Max Capacity flag set may dispatch under any of the “givenOutflow” 
dispatch methods: 

• solveMB_givenOutflowHW for Level Power, Slope Power, and Storage Reservoirs.

• solveMB_givenOutflowStorage for Level Power, Slope Power, and Storage Reservoirs.

• solveMB_givenInflowOutflow for Level Power, Slope Power, and Storage Reservoirs.

• solveMB_givenOutflowInflow for Pumped Storage Reservoirs.

The Outflow Max Capacity flag may NOT be used on reservoirs when solving for Hydrologic Inflow, 
or when solving a Target Operation.

The Max Capacity solution is iterative. The exact sequence of calculations in each iterative loop is 
dependent on the type of Reservoir and the selected Spill Calculation Method. In all cases, the 
maximum Spill and maximum controlled Release are calculated individually, then summed. If the 
selected Spill Method includes Regulated Spill, the current or previous Pool Elevation is used to look 
up the maximum Regulated Spill from the Regulated Spill Table. This value is set in the Regulated 
RiverWare Technical Documentation: Slots
Revised: 4/27/12



30
 

Types of Slots
Series Slot

30
Spill slot, and the selected Spill Calculation Method is called. Any input Bypass and/or required 
Unregulated Spill are considered within the Spill Method. Next, the maximum release is calculated. If 
the Reservoir is a Power Reservoir, the selected Tailwater Calculation Method is executed to determine 
the Operating Head. This Operating Head or the Pool Elevation (in the case of Storage Reservoirs) is 
used to look up the maximum release from the Max Turbine Q table, Max Release table, Max Flow 
Through Turbines table, or Best Generator Flow table. Finally, the maximum release and the calculated 
Spill are added to determine the total maximum Outflow. This Outflow is used to mass balance the 
Reservoir. The iteration is repeated until Convergence is met or Max Iterations is exceeded.

3.1.3.4 Target Operation Flags

Target Operations are used to calculate a lumped mass balance across several timesteps, in order to 
exactly meet a user-input TARGET Pool Elevation or Storage value. Three conditions are necessary for 
a Target Operation to execute successfully:

• An initial value must be known at the timestep before the TARGET BEGIN timestep. This value may 
be INPUT or a known value at the time the Target Operation solves.

• A target Pool Elevation or Storage value must be specified at the TARGET timestep. 

• Either Inflow or Outflow must be known for all timesteps in the target range. 

Given these conditions, RiverWare calculates the unknown Inflows or Outflows for all of the timesteps 
within the Target Operation, such that the TARGET value is exactly met.

Timestep Range:  When solving a target operation, RiverWare searches backwards from the TARGET 
time until it finds a valid TARGET BEGIN flag. The Target Operation is solved using the value from the 
timestep prior to the TARGET BEGIN flag as an initial condition. If the timestep prior to the TARGET 
BEGIN does not have a valid Storage or Pool Elevation, or a valid input value exists between the 
TARGET BEGIN and the TARGET, the simulation aborts with an error. Likewise, if the TARGET 
BEGIN or TARGET timestep already has enough information to dispatch with a different dispatch 
method, simulation aborts. If no TARGET BEGIN flag is specified, RiverWare searches backwards to 
the first valid value and solves the Target Operation with this initial condition.
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When a beginning of target is 
assumed in this manner, 
RiverWare marks the timestep 
where the Target Operation 
actually begins with a tb 
(lowercase) flag in the Open 
Slot dialog. This flag is treated 
as an output, and is 
automatically cleared at the 
start of the next run. Setting a 
Target Operation from an SCT 
generates both the TARGET 
and TARGET BEGIN flags, and 
clears any previous Target 
Operations which overlapped 
with the new range. 

Lumped Mass Balance:  To calculate the unknown flow values, RiverWare performs a lumped mass 
balance over the target range. The required change in Storage is found by subtracting the storage just 
before the TARGET BEGIN (converted from Pool Elevation in the case of a Pool Elevation TARGET) 
from the TARGET value (also converted from Pool Elevation in the case of a Pool Elevation TARGET). 
All of the known Inflows and/or Outflows are then summed to calculate a side flow gain or loss of 
Storage over the target range. This volume of side flows is then subtracted from the change in Storage 
required to meet the TARGET value, and the remaining flow volume is distributed equally among the 
unknown Inflows or Outflows. The following equations represent the calculations discussed above:       

Redispatching:  The setting of flow values on intermediate timesteps of the Target Operation forces the 
object onto the dispatch queue at those times. The timesteps dispatch with enough information to solve 
completely (Inflow and Outflow are known for all timesteps.) The only timestep which actually re-
dispatches is the TARGET timestep, since a valid previous Storage value is now known. 

3.1.3.5 Spill Drift Flags

Spill DRIFT is used to calculate the Regulated or Bypass Spill over a controlled gate as the reservoir 
Pool Elevation changes over time. The flag is always considered an input on any timestep where it is set 
but no value is initially set by the user. In this way, it is similar to the Energy BEST EFFICIENCY and 
MAX CAPACITY flags. Since DRIFT is considered an INPUT, it may affect over determination of Spill 
parameters. 

5/1/95

Storage:

TB or O

5/2/95 5/3/95 5/4/95 5/5/95 5/6/95

T

900,000 NaN NaN NaN NaN 1,000,000

Target Begin Target

OOOI or O
(known) (known)

5/1/95

Storage:

TB or tb

5/2/95 5/3/95 5/4/95 5/5/95 5/6/95

T

900,000 921,236 942,571 961,652 980,712 1,000,000

OOOI or O

GainLoss Storage(TB-1) Storage(T) Inflows Δt×( ) Outflows Δt×( )–+–=

Constant Inflow or Outflow GainLoss Number of Undetermined Timesteps Δt×( )⁄=
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The first timestep prior to initiating drift is used to determine a gate index called the Regulated (or 
Bypass) Drift Index. This index is interpolated from a 3-dimensional Regulated (or Bypass) Spill Index 
Table, which relates Pool Elevation to Spill for various gate indices. In all subsequent timesteps where 
the DRIFT flag is set, the same index is used to determine the new Spill. The gate index is maintained 
throughout the selected time period. At each timestep, the new value of Spill is calculated for the 
structure based on the current average Pool Elevation. 

3.1.3.6 Surcharge Release Flag

The SURCHARGE RELEASE flag is used to calculate the surcharge or mandatory release from a 
reservoir during flood control operations. Surcharge releases are meant to evacuate water from that sits 
above the top of the flood pool. This flag can only be set on the Surcharge Release slot which is only 
available when the user has selected a Surcharge Release Calculation method. The flag is always 
considered an input on any timestep where it is set but no value is initially set by the user.

Although the SURCHARGE RELEASE flag may be set by selecting Timestep I/O p Surcharge 
Release from the Surcharge Release slot, in practice it should only be set by a rule. When the 
SURCHARGE RELEASE flag is set, and the inflow to the reservoir is known, the reservoir can dispatch 
with the solveMB_givenInflowSurchargeRelease dispatch method. This dispatch method will calculate 
the forecasted surcharge releases and will set them on both the Surcharge Release and Outflow slots so 
that they may propagate downstream. The manner in which the forecasted surcharge releases are 
calculated depends on the method selected in the Surcharge Release Calculation category. If the user is 
interested in using one of the surcharge release methods, detailed information can be found HERE 

(Objects.pdf, Section 22.1.15) for the Storage Reservoir.

3.1.3.7 Regulation Discharge Flag

The REGULATION DISCHARGE flag is used to calculate the regulation discharge at a Control Point. 
Regulation discharge is used during flood control operations and is defined as the maximum allowable 
flow in the channel at the control point. This flag should only be set on the Regulation Discharge Calc 
slot on Control Points. This slot is only available when the user has selected a Flood Control method 
and a Regulation Discharge method. The flag is always considered an input on any timestep where it is 
set but no value is initially set by the user. Like the SURCHARGE RELEASE flag, the REGULATION 
DISCHARGE flag should only be set by a rule. If the user is interested in using one of the Regulation 
Discharge methods, detailed information can be found HERE (Objects.pdf, Section 9.1.9).

3.1.3.8 Unit Values Flag

The UNIT VALUES (U) flag is used to indicate that the user is going to specify unit level values but 
would like to use those to drive the solution. The UNIT VALUES flag may be set on Energy or Turbine 
Release on power reservoirs that have the Unit Power (HERE (Objects.pdf, Section 16.1.1.12)) method 
selected. If the Unit Power method is not selected, an error is issued. This flag is considered a user input 
but does not require a value (similar to the MAX CAPACITY and BEST EFFICIENCY flag). At the 
beginning of the run any numeric values are cleared out. The flag can be set directly on the slot, from 
the SCT or from a Rule. 
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U Flag on Energy:  Thus, if the U flag is set on Energy, one or more Unit Energy subslots must be 
specified by user input or a rule. When RiverWare runs, it sees that Energy has this flag which is 
considered an input. If it has enough other information (like Inflow, Storage, or PE), the reservoir will 
be able to dispatch one of the following methods:

• solveMB_givenEnergyInflow

• solveMB_givenEnergyStorage

• solveMB_givenEnergyHW

In addition, Energy can be flagged U, if the reservoir dispatches one of the following methods:

• solveMB_givenInflowOutflow

• solveMB_givenOutflowHW

• solveMB_givenOutflowStorage

These methods do not require energy to be unknown.

U Flag on Turbine Release:  Alternatively, if the U flag is set on Turbine Release, one or more Unit 
Turbine Release subslots must be specified as user input or by a rule. When RiverWare runs, it sees that 
Turbine Release has this flag which is considered an input. If it has an Inflow, the reservoir will be able 
to dispatch the solveMB_givenInflowRelease method.

Because this flag is specific to the Unit Power method, the full algorithm is described HERE (Objects.pdf, 

Section 16.1.1.12).

3.1.4 Finding Inputs

The Find Series Slots with 
Inputs utility can be used to find 
values that are input in the model. 
It is accessed from the RiverWare 
Workspace using the: Workspace 
p Slots p Find Inputs... menu. 
The dialog shown to the right 
opens. 

The user has options to filter on 
the types of series slots on which 
to look for input values. In a pure 
simulation model, this is only 
Physical Slots (i.e. Outflow, 
Inflow, etc.) If Accounting is 
enabled, the user may choose to 
search any or all of the following 
series slot “domains”:

• Physical Slots
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• Account Slots

• Supply Slots

• Exchange Slots

The search may be limited to either Initialization Timesteps (before the Run Start timestep) or Run 
Period Timesteps (on or after the Run Start timestep). If both are checked, all series slots having any 
inputs are found, regardless of where (in time) those Input values are within the slots' time series.

The search operation is performed by clicking the Search push button. The number of series slots with 
Input-flagged timesteps, and the total number of series slots matching the checked “domains” are 
indicated in a status line to the right of the search button. If search criteria is changed (by clicking any 

of the check boxes at the top of the dialog), a green check icon  is displayed next to the search 
button indicating that a new search with the new criteria has yet to be performed. The green check icon 
is hidden upon performing another search.

The user has the option of showing the slots' object name and account name (if applicable) in separate 
columns. This is controlled by the Compress columns check box below the slot list. This is not 
available if supply slots or exchange slots are shown in the slot list,

Several context menu (right click) operations are available within the slot list:

• Open Slot -- Show the open slot dialog for the picked slot item.

• Open Object -- Show the open object dialog for the picked slot item (if applicable).

• Copy Slots -- Put the selected slot items into the slot clipboard, e.g. to paste into an output (manager) 
device slot list.

Buttons along the bottom of the dialog provide these functions:

• Open Slots: Separate open slot dialogs are shown for each of the selected items in the list. If more 
than four (4) slots are selected, then a query dialog box is shown confirming the operation with a mes-
sage like this: “Do you want to show 421 Open Slot dialogs?”. Note that all shown open slot dialogs 
may be hidden with the Workspace p Slots p Close All Slots... menu operation.

• Show All Slots in SCT: All slots in the list (regardless of item selection) are shown in a new SCT dia-
log, and the Find Series Slots with Inputs dialog is closed.

• Show Selected Slots in SCT: Selected slots in the slot list are shown in a new SCT dialog, and the 
Find Series Slots with Inputs dialog is closed.

• Cancel: The Find Series Slots with Inputs dialog is closed.

The dialog can also be used to find slot descriptions as described HERE (Section 1.3).
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3.2 Agg Series Slots

Aggregate Series Slots (Agg Series) are specialized Series 
Slot that group together one or more Series Slots which are 
independent of one another. They are used to group together 
similar series of data. Agg Series slots are essentially 
multiple individual series of data. The columns of an Agg 
Series Slot are often referred to as Sub Slots. The screenshot 
to the right shows the Evapotranspiration Rate by Crop for 
two different crops, Corn and Wheat. 

3.2.1 Configuration

Following are configuration options specific to Agg Series 
Slots. Further information on general configuration can be 
found HERE (Section 1.2.5) and HERE (Section 3.1.1) for Series 
Slots.

Agg Series slots can be configured such that each column 
is configured identically or each is configured individually. 
In the Configuration dialog, there is a toggle to configure 
the columns identically or separately as shown:

3.2.2 Other Options

Because each column can be configured separately, the time range of each column can be configured to 
have different start and end dates. The two options allow the columns of the agg series to synch back 
together:

Max Synch:  The Edit p Max Synch option will synchronize each column to fully encompass the 
earliest and latest date displayed on any column of the slot. For example, if column 1 goes from Jan. 1, 
1999 to June 1, 1999 and column 2 goes from Feb. 2, 1999 to July 23, 1999, a Max Synch will change 
the range of both columns to be Jan. 1, 1999 to July 23, 1999. 

Synch to Column0:  The Edit p Synch to Column0 option will synchronize each to column to match 
the first column (i.e. column 0). On the previous paragraphs example, a Synch to Column0 will change 
the range of all columns to be Jan. 1, 1999 to June 1, 1999.

Note: Many of the general slots in RiverWare, such as Outflow, Storage, and Pool Elevation are Agg 
Series slots. This is an artifact of how the original optimization system was designed. When enabled, 
optimization used the second and third columns in the solution. In the current controllers, these columns 
are never used and can be ignored. In this case, the user can think of a single column Agg Series as a 
normal Series Slot.
RiverWare Technical Documentation: Slots
Revised: 4/27/12



36
 

Types of Slots
Multi Slots

36
3.3 Multi Slots

Multi Slots are specialized series slots that 
automatically sum the values of the slots to which 
they are linked. In the screenshot, two series slots 
named Gage Above Bartlett. Gage Outflow and 
Reach2.Outflow are linked to the Bartlett.Inflow 
slot. Each of the linked slots appears in a column. 
The cells for these columns are grey hatched 
indicating that they are not directly editable from 
this view. The user should edit these values from 
the other end of the link. The sum of all linked 
columns is reported in the Total column. The 
columns of a Multi Slot are often referred to as 
Sub Slots. All of the sub slots must have the same 
unit type and user unit although the other end of 
the link can have a different user unit, conversion 
is automatic.

Configuration of Multi Slots is similar to Series Slots HERE (Section 3.1.1). On Multi Slots there is a 
toggle at the bottom of the dialog that is used to hide or show the subslots. The check box is shown only 
if the MultiSlot has at least one subslot. It is initialized to OFF if the MultiSlot has exactly one subslot, 
otherwise, it is initialized to ON. This can be useful for subslots that only have one link, hence it really 
only represents one series of data.

3.4 Integer Indexed Series Slots and Agg Series

Integer Indexed Series Slots (and Integer Indexed Agg Series Slots) are a specialized type of series slots 
whose range is not associated with dates, rather just their order in the series. The indices are 1-based, 
i.e. the first value has index 1. 
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Configuration of Integer Indexed Series Slots is similar to Series 
Slots HERE (Section 3.1.1) but, because the series is incremented by 
integer, there are a few differences between this type of slot and a 
standard series slot. The View menu now has a Series Range 
menu instead of the standard Timeseries Range menu option. In 
the Series Range menu (the Configure Series dialog), the 
Begin, End, and timestep areas are disabled. The user can change 
the range only by changing the number of values.

Note: Internally, the slot is actually a standard series slot with a 1 
hour timestep starting on 24:00 December 31, 1799. This can be 
important because this date is shown in the date scroll area.

Integer Indexed Series slots can be used as a part of the following 
utilities:

• They are plotted with integer values with units of NONE for the 
x dimension. 

• They can be accessed and set from the RiverWare Policy Lan-
guage. Integer Indexed Slots are particularly useful in Iterative 
MRM mode as they can be used to store values for a particular run index.

• They can be displayed on a System Control Table (SCT). Note, the SCT can either show standard time 
series or integer indexed series, but not both. 

3.5 Expression Slots - Series

Expression slots are computational expressions. The user can either create a Series Slot with 
Expression or a Scalar Slot with Expression. They are used to calculate quantities such as “combined 
Storage of all Reservoirs,” “weekly average Outflow of Hoover Dam,” “the ratio of Hydrologic Inflow 
to Reach Inflow at selected structures”, or any conceivable equation. Expression slots (both series and 
scalar) are available only on Data Objects. To add a Series slot with expression select Slot p Add 
Series Slot with Expression. 
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Expression slots utilize the RiverWare Policy Language 
(RPL). RPL is computationally expressive language and 
has an associated structured editor. Because Expression 
slots utilize RPL (the same language in which 
RiverWare rules are written) they may contain simple 
expressions or complex logic and functions. Anything 
that may be expressed in a rule may also be evaluated in 
an Expression slot. The use of RPL also provides 
dimensional analysis to ensure that units are reconciled 
throughout the expression. It is important to make sure 
that the unit type of the slot is the same as the units to 
which the expression evaluate. 

3.5.1 Configuration

Following is description of the configuration options 
available for expression slots. 

3.5.1.1 File Menu

On the File menu, the Import options are not available as 
you cannot import or type data into the slot. The export 
options are available and can be used to export the 
calculated data out of the slot. A Print Expression menu 
option is available to print the expression. This uses the 
same printing mechanism as other RPL sets, described 
HERE (RPLUserInterface.pdf, Section 3.1).

3.5.1.2 Edit Menu

On expression slots, the Edit menu has options to Copy (to the RiverWare clipboard) and Export Copy 
(to the system clipboard). Importing, pasting, and other data editing features are disabled as the 
expression slot is “output only”.
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3.5.1.3 View Menu

The View Menu on expression slots show the following menu 
options: 

Configuration:  The configuration uses the standard series slot 
configuration dialog described HERE (Section 3.1.1).

Evaluation Range:  By default, Expression slots are evaluated 
for each timestep in the model run (i.e., the range is 
synchronized with the run control). If you are only interested in 
the result of an expression for a reduced range of dates or for a 
different timestep, you may select View p Evaluation Range, 
deselect Always Synch with Run Control and enter the date 
range in which you are interested.

Note: An expression slot does not need to have the same timestep as the run control. If the user chooses 
to Always Synch with Run Control but uses a different timestep than the run, the slot will evaluate for only 
those timesteps that fall within the run dates.

Open RPL Set:  The RPL set containing functions used by any expression slot can be opened by View 
p Open RPL Set. All of the functionality associated with a RPL set can be utilized from this RPL set 
editor such as importing/exporting, analysis, search and replace, and creating utility groups of 
functions. Note, that only functions will be shown in the RPL set editor, the expressions on the slots 
themselves are the equivalent to the rules in a ruleset. Click HERE (RPLUserInterface.pdf, Section 1) for 
more information on RPL sets. From the RPL set, the user can control the layout using the Set  p 
Layout... menu. Click HERE (RPLUserInterface.pdf, Section 3.2) for more information on layouts.

3.5.1.4 Expression Menu

Show Expression:  This toggle is used to show or hide the expression. By default, the expression is 
shown.

Evaluate:  The user can manually evaluate the expression from the Expression p Evaluate menu.

Validate:  The user can manually verify the expressions validity using the Expression p Validate 
menu. 

Time Range
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Evaluation Time:  Expression slots can be evaluated at the 
beginning or end of each simulation run, at the beginning or 
end of each timestep, never, or interactively on demand. 
These options are particularly useful for performance when 
running large models and when evaluating a large number 
of expression slots. To select when an Expression slot is 
evaluated select Expression p Evaluation Time from the 
Expression slot menu, and choose from the options shown 
to the right. A check mark will be shown next to the selected option. 

The Expression menu is used to build expressions. There are options to Cut, Copy, Paste, Delete, and 
Enable and expression. Undo and Redo are available to go back or go forward when editing 
expressions. These are only available when a relevant expression is selected. Finally, there is a menu 
option to bring up the Palette open the RPL Debugger and open the RPL set.

Show Comments:   The Show Comments menu allows you to hide or show 
inline RPL comments (added from the palette). There is also a toggle on the slot 
dialog below the RPL expression that hides/shows the comments (shown to the 
right). Comments are shown by default. If there are any comments defined, a box is shown around the 
toggle. 

3.5.2 Building Expressions

Expression slots utilize the RPL palette to build expressions. The RPL palette provides a syntax-guided 
editor designed to assist in the construction of complex syntactically correct expressions within the 
RiverWare Policy Language environment. The editor works by maintaining a partially constructed 
expression and allowing the user to manipulate unfinished portions using the palette. Initially, the 
buttons in the palette are grayed out. When building an expression, the palette enables any buttons that 
could possibly go in a highlighted portion of the expression. 

See the documentation HERE (RPLUserInterface.pdf, Section 1) on RPL and the palette for further 
information on any of the RPL topics described.

Note: For Expression Series Slots, the symbolic datetime specifications @”Start Timestep” and @”Finish 
Timestep” refer to the expression slot’s evaluation range, not the controller’s start or end dates. The 
predefined functions, RunStartDate() and RunEndDate(), HERE (RPLPredefinedFunctions.pdf, Section 
133), provide a reference to the controller’s start and end dates, respectively

3.5.3 Diagnostics for Expression Slots

Diagnostics for expression slot evaluation can be configured in the Diagnostics Manager HERE 

(Diagnostics.pdf, Section 1.2). 

If expression slots are evaluated outside of a run, using the Expression  p Evaluate menu on the slot 
or the Control p Evaluate Expression Slots menu from the workspace, then diagnostics must be set 
up using the Workspace diagnostics HERE (Diagnostics.pdf, Section 5.1). 
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If expression slots are evaluate during a run, either beginning or end of timestep or beginning or end of 
run, then diagnostics must be set up using Simulation diagnostics HERE (Diagnostic.pdf, Section 2.1) or 
Rulebased Simulation diagnostics HERE (Diagnostics.pdf, Section 3.1), depending on the selected 
controller. Within each of those diagnostics configurations, the Expr. Slot Execution and Expr. Slot 
Function Execution categories deal with expression slots.
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3.6 Table Slots

Table Slots are used to store any table of data. They can define 
a curve (2-Dimensional), a surface (3-Dimensional), or several 
unrelated sets. A 2-Dimensional table may require 
monotonically increasing values in its first column as shown in 
the Elevation Volume table. 

3.6.1 Configuration

The configuration of Table Slots is described in the general slot 
configuration section HERE (Section 1.2.5). Each column of the 
table has both a Label and a Unit (user units are configurable). 
On simulation objects, the Rows are labeled by number unless 
defined otherwise. Both columns and rows are zero based, i.e. 
the first column is column 0. On Data Objects, the user is able 
to change both the Units, Display Format, Column Labels, and 
Row Labels. Table Slots can be configured such that each 
column is configured identically or each is configured 
individually. In the Configuration dialog, there is a toggle to configure the columns identically or 
separately as shown below:
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A 3-Dimensional table requires that column 1 contain sets of 
equal values which increase down the table, and column 2 
must contain monotonically increasing values within each set 
of values from column 1. Column 3 then contains the values to 
look up for columns 1 and 2. For example, the Stage Flow 
Tailwater Table is a 3-Dimensional table relating TW 
Elevation to the independent variables of reservoir Outflow 
and Downstream Stage. A set where Outflow is equal to 
20,000 cfs is highlighted.

Edit Row Configuration:  The user is able to change the 
number of rows in most tables. This is done through the Row 
menu using the Insert/Append/Delete rows options. 

Editing Column Configuration:  Some Table Slots allow 
columns to be appended and deleted. This is done to store a 
variable number of data sets within a single slot. A “block” is 
defined as the number of columns which must be appended or 
deleted together. In the case of the Elevation Volume Table, the 
block size is 2, one column for Pool Elevation and one for 
Storage (although the user can’t add blocks to this table). 
When appending or deleting columns from a Table Slot and its dependents, reconfiguring must be done 
in blocks. The minimum table size is 1 block. The user can change the number of columns using the Set 
Number of Columns, Append Column, Delete Column, Delete Last Column, and Set Dimensions 
menu options from the Column menu. The Column  Set Dimensions can also be used to change the 
number of rows and columns at the same time.

Show Column Sum Row:  The user is able to show the sum of the column rows using the View  
Show Column Sum Row menu item. This option adds a special read-only SUM row to the bottom of 
the column that sums all of the values above (NaNs are assumed to be zero). This feature is especially 
useful when setting up routing coefficients or factors where the sum of the column must equal 1.0.

3.6.2 Source Slots

Some specific scalars and tables have a “Source” slot. When a slot has a source slot, the values are 
computed from the source slot’s values. Thus, the destination slot becomes read-only and displays a 
cross hatch over the data. The slot also provides a note indicating the source slot used to compute the 
data. The source slot is typically set/un-set at beginning of run, so you must initialize the run to see the 
read-only status.
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3.7 Table Series Slot

Table Series Slots are a specialized table slot whose rows 
correspond to time values. This slot contains limited 
timeseries functionality thus making it more efficient 
than Series Slots. It was created as a way to efficiently 
write and/or read large amounts of data. Table Series 
Slots are primarily used within object user methods such 
as the Muskingum Cunge hydraulic routing methods. 
These types of slots cannot be created on Data Objects.

3.8 Statistical Table Slots

Statistical table slots allow the user to specify a statistical 
function, such as a flow duration curve, which is 
computed at the end of a run using the data in specified 
model slot(s). This statistical analysis data can then be plotting or exported to another application.

This statistical analysis could be computed using Riverware’s existing export or output manager 
functionality coupled with a third-party analysis application such as Excel. Statistical table slots 
provides this functionality inside Riverware to allow quick analysis at the end of a run without leaving 
the Riverware environment.

3.8.1 Creating a Statistical Table Slot

Statistical table slots can only be added to data objects. To create a statistical table slot, open the object 
dialog for a data object. From this dialog:

• Select Slot  Add Statistical Table Slot from the data object’s main menu bar.

• Right-click over the slots list and select Add Slot  Statistical Table Slot from the context menu.

A statistical table slot will be displayed in the slot list with the slot icon: 
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3.8.2 Configuring a Statistical Table Slot.

A statistical table slot is configured and viewed using the Statistical Table Slot Dialog. Open this dialog 
by double-clicking on the statistical table slot in the data object dialog.

The basic steps in configuring a statistical table slot are:

1. Select the desired statistical function from the Function pull-down list. The functions are described 
HERE (Section 3.8.6).

2. Select the input slot for the statistical function by pressing the Select Slot... button. A selected input 
slot can then be opened by pressing the icon next to the Select Slot... button.

Open Input SlotSelect Input Slot Select Statistical Function

Filter Input DataView Applied Filter
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3. Select any desired filtering of the input data by 
pressing the Filter Input Data... button. Data can 
be filtered by:

• Time Range, select the Run Range (default), 
full Slot Data Range, or a Specified Range 

• Months, choose the desired months

• Values Greater than a Minimum

• Values Less than a Maximum

• A specified Number of Largest Values 

Multiple filters can be applied concurrently. A 
summary of any applied filtering can be viewed 
on the Statistical Table Slot Dialog in the Filter 
text window.

4. Specify the display units, scale, and precision 
for each column in the table by selecting View  
Configure... from the dialog’s menu bar.

3.8.3 Evaluating a Statistical Table Slot

By default, all statistical table slots will be cleared 
at the beginning of the run and evaluated at the 
end of the run. 

• To prevent a statistical table slot from being evaluated at the end of the run select Evaluation  Dis-
abled on the dialog’s menu bar.

The contents of a statistical table slot can also be cleared and evaluated manually.

• To manually evaluate a statistical table slot select Evaluation  Evaluate (Alt+E) from the slot dia-
log’s menu bar.

• To manually clear the contents of a statistical table slot select Evaluation  Clear from the slot dia-
log’s menu bar.

3.8.4 Analyzing a Statistical Table Slot.

Snapshots can be made of statistical slots to easily preserve and compare their values from different 
runs. 

• To create a snapshot of the statistical slot select View  Snapshot Mgr (Alt+S) from the slot dialog’s 
menu bar.

• The snapshot manager dialog will be opened and the statistical slot and its input slot will be added to 
the manager’s slot list if not already present.

• Taking a snapshot creates a data object with copies of all slots that are in the manager’s list.
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• To preserve the data, the snapshots of statistical slots have all functionality disabled that could change 
the values of the data in the slot.

3.8.5 Plotting a Statistical Table Slot

The contents of a statistical table slot can be plotted.

• To plot the contents of the statistical table slot select File  Plot (Ctrl+P) from the slot dialog’s menu 
bar.

• If the statistical slot has more than 2 
columns, a dialog appears to allow 
specification of which columns to 
plot (some functions may present a 
check box option for plotting all the 
result data columns, for example to 
plot all duration columns from a 
value duration function). A typical 
choice would be percent 
exceedence probabilities versus val-
ues. In this case, the percent 
exceedences will, by default, be 
plotted on a probability scale as you 
would see on normal probability 
paper. On such a scale, normally 
distributed values will plot as a 
straight line. A sample is shown to 
the right.

• If desired, the probability axis can 
be changed to a linear scale by 
selecting Edit  Axis Configura-
tion from the plot dialog’s menu 
bar, then choosing the X-Axis and changing the toggle.

• The axes of the generated plot can also be configured to be logarithmic by selecting Edit  Axis Con-
figuration from the plot dialog’s menu bar. This can be used, for example, to plot a log-normal repre-
sentation of the data.

• The configuration of the plot can be saved for quick access by using either the output manager or the 
File  Save As... option on the plot dialog.

A statistical slot can be plotted with all of its snapshots.

• To plot the contents of the statistical table slot along with all of its snapshots, select File  Plot with 
Snapshots (Alt+P) from the slot dialog’s menu bar.
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• If the statistical slot has more than 2 columns, a dialog appears to allow specification of which col-
umns to plot (some functions may provide a check box option to plot all the result data columns). The 
selections are used for the slot as well as for all the snapshots.

• The slot’s data and the data in all of its snapshots are plotted on the same graph to allow for an easy 
visual comparison.

• The axes of the generated plot can be configured to logarithmic scale by selecting Edit  Axis Con-
figuration from the plot dialog’s menu bar.

• The configuration of this plot can be saved for quick access by using either the output manager or the 
File  Save As... option on the plot dialog.

User data input to a table slot can be plotted with a statistical slot.

• Add a table slot to your data object by selecting Slot  Add Table Slot from the data object’s menu 
bar.

• A dialog will appear asking for the number of rows and columns you want in your table slot. You will 
probably want at least two columns to plot the slot.

• The new table slot with a default name will appear in the slot list of the data object’s dialog. Double 
click on the new table slot in this list to bring up the table slot’s dialog. 

• Select View  Column Labels from the table slot’s dialog. Give the columns heading names in the 
new dialog that comes up and click OK.

• Now select View  Configure from the table slot’s dialog. Assign Unit Type and User Units to your 
columns by using the Configure Each Column Separately option.

• Enter the desired data into the cells of the table slot’s dialog.

• From a plot of your statistical slot, select Data  Add Table Curve from the plot’s menu bar.

• From the resulting Curve Configuration dialog, click the Select Table Slot button and select the table 
slot you created above.

• The Curve Configuration dialog will allow you to select what columns you wish to plot on the x and y 
axes of the plot along with line styles and formats.

• Clicking OK on the Curve Configuration dialog will then add your user input data from the table slot 
onto the plot with the statistical slot.

The contents of the statistical table slot can also be exported to a text file for analysis using an external 
tool.

• To export the contents of the table slot select File  Export (Display Precision) or File  Export 
(Model Precision) from the slot dialog’s menu bar.

3.8.6 Statistical Functions

The following statistical functions are provided on Riverware’s statistical table slots.
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3.8.6.1 Duration Curve

3.8.6.2 Annual Max Frequency Curve

Name Duration Curve

Input Slot(s) 1 series slot

Column 0
Label: Percent of time equaled or exceeded
Unit Type: Fraction

Column 1
Label: [Name of input slot]
Unit Type: [Unit type of input slot]

Column 2
Label: Rank
Unit Type: None

Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Sort all n resulting values in decreasing order.

3. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m = n. 

4. Compute the statistical exceedence percentage value (P) for each item 
using the formula: P = m / n.

5. The final output is the list of: P, the slot values in sorted descending order, 
rank, and date of the values. 

Annual Max Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Max exceedence frequency in percent of years
Unit Type: Fraction

Column 1
Label: [Name of input slot]
Unit Type: [Unit Type of input slot]

Column 2
Label: Rank
Unit Type: None
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Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Create a list of the maximum annual values for each year within the 
resulting data.

3. Sort all n annual values in decreasing order.

4. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m=n. 

5. Compute the statistical exceedence percentage value (P) for each item 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on rank.

6. The final output is the list of: P, the max annual values in sorted descending 
order, rank, and date of the value.

Annual Max Frequency Curve

P1 1 0.51 n⁄–=
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3.8.6.3 Annual Min Frequency Curve

3.8.6.4 Annual Avg Frequency Curve

Annual Min Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Min exceedence frequency in percent of years
Unit Type: Fraction

Column 1
Label: [Name of input slot]
Unit Type: [Unit Type of input slot]

Column 2
Label: Rank
Unit Type: None

Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Create a list of the minimum annual values for each year within the 
resulting data.

3. Sort all n annual values in increasing order.

4. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m=n. 

5. Compute the statistical exceedence percentage value (P) for each item 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on rank.

6.The final output is the list of: P, the min annual values in sorted ascending 
order, rank, and date of the value.

Annual Avg Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Avg exceedence frequency in percent of years
Unit Type: Fraction

Column 1
Label: [Name of input slot]
Unit Type: [Unit Type of input slot]

Column 2
Label: Rank
Unit Type: None

P1 1 0.51 n⁄–=
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3.8.6.5 Monthly Maximums By Year

Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Create a list of the average annual values for each year within the resulting 
data.

3. Sort all n annual values in decreasing order.

4. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m=n. 

5. Compute the statistical exceedence percentage value (P) for each item 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on rank.

6. The final output is the list of: P, the avg annual values in sorted descending 
order, rank, and date of the value.

Monthly Maximums By Year

Input Slot(s) 1 series slot

Column 0
Label: Year
Unit Type: DateTime

Columns 1 - 12
Label: [Month} Max
Unit Type: [Unit Type of input slot]

Column 13
Label: Annual Max
Unit Type: [Unit Type of input slot]

Final Rows
Labels: Maximum, Minimum, Average (of the columns)
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Iterate the data and track and save the maximum value for each month and 
for each year.

3. Generate average maximum values for each month across all years and for 
the annual maximum across all years.

4. The final output is a row for each year and final rows for maximums, 
minimums, and averages across all the years. Columns are the date for the 
year, a column for each month’s maximum, and an annual maximum column.

Annual Avg Frequency Curve

P1 1 0.51 n⁄–=
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3.8.6.6 Monthly Minimums By Year

3.8.6.7 Monthly Averages By Year

Monthly Minimums By Year

Input Slot(s) 1 series slot

Column 0
Label: Year
Unit Type: DateTime

Columns 1 - 12
Label: [Month} Min
Unit Type: [Unit Type of input slot]

Column 13
Label: Annual Min
Unit Type: [Unit Type of input slot]

Final Rows
Labels: Maximum, Minimum, Average (of the columns)
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Iterate the data and track and save the minimum value for each month and 
for each year.

3. Generate average minimum values for each month across all years and for 
the annual minimum across all years.

4. The final output is a row for each year and final rows for maximums, 
minimums, and averages across all the years. Columns are the date for the 
year, a column for each month’s minimum, and an annual minimum column.

Monthly Averages By Year

Input Slot(s) 1 series slot

Column 0
Label: Year
Unit Type: DateTime

Columns 1 - 12
Label: [Month} Avg
Unit Type: [Unit Type of input slot]

Column 13
Label: Annual Avg
Unit Type: [Unit Type of input slot]
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3.8.6.8 Monthly Totals By Year
Note that totals generated by this function may not make sense for some slots (i.e, flow or storage).

Final Rows
Labels: Maximum, Minimum, Average (of the columns)
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Iterate the data and calculate and save the average value for each month 
and for each year.

3. Generate averages from the average values for each month across all 
years and for the annual average value across all years.

4. The final output is a row for each year and final rows for maximums, 
minimums, and averages across all the years. Columns are the date for the 
year, a column for each month’s average, and an annual average column.

Monthly Totals By Year

Input Slot(s) 1 series slot

Column 0
Label: Year
Unit Type: DateTime

Columns 1 - 12
Label: [Month} Tot
Unit Type: [Unit Type of input slot]

Column 13
Label: Annual Tot
Unit Type: [Unit Type of input slot]

Final Rows
Labels: Maximum, Minimum, Average (of the columns)
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Iterate the data and track and save the total value for each month and for 
each year.

3. Generate average total values for each month across all years and for the 
annual total across all years.

4. The final output is a row for each year and final rows for maximums, 
minimums, and averages across all the years. Columns are the date for the 
year, a column for each month’s total, and an annual total column.

Monthly Averages By Year
RiverWare Technical Documentation: Slots
Revised: 4/27/12



55
 

Types of Slots
Statistical Table Slots

55
3.8.6.9 Partial Duration Max Frequency Curve

3.8.6.10 Partial Duration Min Frequency Curve

Partial Duration Max Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Max exceedence frequency in percent
Unit Type: Fraction

Column 1
Label: [Name of input slot]
Unit Type: [Unit Type of input slot]

Column 2
Label: Rank
Unit Type: None

Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. If user has specified a base value, use it in the call to the partial duration 
calculation and present all the results generated.

3. If not a user-supplied base value, sort the input values in decreasing order 
and assume a base equal to the value at position (number of years of input 
data plus one). Make successive calls to the partial duration calculation with 
decreasing base values until the number of results equals or exceeds the 
number of years of data in the input slot.

4. The partial duration calculation tabulates the largest values that are greater 
than the base value, which are separated by events less than the base value.

5. Sort all n result values in decreasing order.

6. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m=n. 

7. Compute the statistical exceedence percentage value (P) for each item. 
For the top half of items, use the formula: ; Pn = 1 - P1 ; P for 
all others in the top half are interpolated between these two based on rank. 
For the bottom half of items, use the formula: 

8. The final output is the list of: P, the max partial duration values in sorted 
descending order, rank, and date of the value.

Partial Duration Min Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Min exceedence frequency in percent
Unit Type: Fraction

P1 1 0.51 n⁄–=

2m 1–
2n

----------------
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Column 1
Label: [Name of input slot]
Unit Type: [Unit Type of input slot]

Column 2
Label: Rank
Unit Type: None

Column 3
Label: Date
Unit Type: DateTime

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. If user has specified a base value, use it in the call to the partial duration 
calculation and present all the results generated.

3. If not a user-supplied base value, sort the input values in increasing order 
and assume a base equal to the value at position (number of years of input 
data plus one). Make successive calls to the partial duration calculation with 
increasing base values until the number of results equals or exceeds the 
number of years of data in the input slot.

4. The partial duration calculation tabulates the smallest values that are less 
than the base value, which are separated by events greater than the base 
value.

5. Sort all n result values in increasing order.

6. Assign a rank to each sorted item from 1 to n. The rank of the item is m. 
For the largest slot value, m=1. For the smallest slot value, m=n. 

7. Compute the statistical exceedence percentage value (P) for each item. 
For the top half of items, use the formula:  ; Pn = 1 - P1 ; P for 
all others in the top half are interpolated between these two based on rank. 
For the bottom half of items, use the formula: 

8. The final output is the list of: P, the min partial duration values in sorted 
ascending order, rank, and date of the value.

Partial Duration Min Frequency Curve

P1 1 0.51 n⁄–=

2m 1–
2n

----------------
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3.8.6.11 Value Duration Max Frequency Curve

3.8.6.12 Value Duration Min Frequency Curve

Value Duration Max Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Max exceedence frequency in percent of years
Unit Type: Fraction

Columns 1 - N
Label: [Duration represented by column]
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Determine the durations to use in calculation based on timestep of input 
slot. Currently only implemented for day (1, 2, 3, 5, 7, 19, 15, 60, 90 and 365 
day) and month (1, 2, 3, 4, 6 and 12 month)

3. Loop for each duration.

4. For each year, average the slot values over the duration starting with 
timestep 1, then starting with timestep 2, etc. to generate a set of values over 
this duration for the year. Take the maximum of this set of values and record 
this as the single result for the year.

6. Sort all the result values (one for each year) in decreasing order and 
present as a column of results for this duration.

7. Move on to the next duration.

4. Assign a rank to each row of results from 1 to n.

5. Compute the statistical exceedence percentage value (P) for each row 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on row rank.

6. The final output is the list of: P and a column of results for each duration 
used.

Value Duration Min Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Min exceedence frequency in percent of years
Unit Type: Fraction

P1 1 0.5
1 n⁄–=
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Columns 1 - N
Label: [Duration represented by column]
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Determine the durations to use in calculation based on timestep of input 
slot. Currently only implemented for day (1, 2, 3, 5, 7, 19, 15, 60, 90 and 365 
day) and month (1, 2, 3, 4, 6 and 12 month)

3. Loop for each duration.

4. For each year, average the slot values over the duration starting with 
timestep 1, then starting with timestep 2, etc. to generate a set of values over 
this duration for the year. Take the minimum of this set of values and record 
this as the single result for the year.

6. Sort all the result values (one for each year) in increasing order and 
present as a column of results for this duration.

7. Move on to the next duration.

4. Assign a rank to each row of results from 1 to n.

5. Compute the statistical exceedence percentage value (P) for each row 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on row rank.

6. The final output is the list of: P and a column of results for each duration 
used.

Value Duration Min Frequency Curve

P1 1 0.51 n⁄–=
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3.8.6.13 Value Duration Avg Frequency Curve

3.9 Periodic Slots

Periodic slots are tables used to represent periodic data which repeats at regular time interval. An 
example might be a set of evaporation coefficients for a reservoir. The rate of evaporation varies with 
such factors as temperature and wind speed, factors which vary seasonally. It is natural to assume that 
this variation is the same for each year. If this sort of data were entered into a series slot, then the same 
data would need to be repeated every year. This would be impractical and inconvenient for the user. On 
the other hand, if this data were entered in to a table slot, then the data would lose the time element 

Value Duration Avg Frequency Curve

Input Slot(s) 1 series slot

Column 0
Label: Avg exceedence frequency in percent of years
Unit Type: Fraction

Columns 1 - N
Label: [Duration represented by column]
Unit Type: [Unit Type of input slot]

Algorithm

1. Filter the input data from the input slot per the user’s specifications.

2. Determine the durations to use in calculation based on timestep of input 
slot. Currently only implemented for day (1, 2, 3, 5, 7, 19, 15, 60, 90 and 365 
day) and month (1, 2, 3, 4, 6 and 12 month)

3. Loop for each duration.

4. For each year, average the slot values over the duration starting with 
timestep 1, then starting with timestep 2, etc. to generate a set of values over 
this duration for the year. Take the average of this set of values and record 
this as the single result for the year.

6. Sort all the result values (one for each year) in decreasing order and 
present as a column of results for this duration.

7. Move on to the next duration.

4. Assign a rank to each row of results from 1 to n.

5. Compute the statistical exceedence percentage value (P) for each row 
using the formula: ; Pn = 1 - P1 ; P for all others interpolated 
between these two based on row rank.

6. The final output is the list of: P and a column of results for each duration 
used.

P1 1 0.5
1 n⁄–=
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associated with each value. This would make it difficult to look up or interpolate values with respect to 
time. The periodic slot solves both of these problems. 

3.9.1 Configuration Options

Periodic slots are configured like other slots using the View  
Configure menu.

The upper left portion of the Configure Slot dialog, under the 
Period section, is used to set the period and interval of the 
periodic slot. The period can range from 6-hours to several 
years while the interval depends on the period selected. If the 
period required is several years, the Qty value should be 
modified from 1 to the number of years and the Base year--
the first year in the period--should be defined. Also notice the 
checkbox next to Regular Interval. If the data interval is not a 
consistent length of time, the user can de-select this option 
and the periodic slot would then have an irregular interval. 
The user is then free to configure the rows/timesteps in any 
fashion. Click HERE (Section 3.9.1.1) for more information.

The Data Interp. section located in the upper right portion of the Configure Slot dialog is used to 
specify whether or not data should be interpolated or looked up directly when accessing the table at a 
time that is not specifically listed as a row label. For example, the monthly data is shown for the 
beginning of each month. If we’re in the middle of the month, should we use that same piece of data, or 
should we interpolate between the two months? This is a question that would need to be answered on a 
per model basis, however, the default behavior is a direct lookup.

 Text Headers  Numeric Headers

Table Value
Units

Header Units

Interpolate or 

Period 

Lookup

and Interval

Header Value
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Note: Slots configured to Lookup use the value in the row that has a datetime less than or
equal to the desired datetime and the datetime in the next row is greater than the desired
datetime. Slots configured to Interpolate, perform a linear interpolation using values whose
rows’ datetimes bound the desired datetime.

Columns can be added/deleted by selecting a column and using the Column menu.

3.9.1.1 Display of Dates

The rows of a periodic slot represent dates and are displayed differently if the interval is Regular or 
Irregular. This distinction in dates is described below.

Regular Intervals:  Regular Interval periodic slots only show enough information to identify the date. 
The display is different if the slot is configured to Lookup or Interpolate. When the slot is configured to 
Lookup, the rows only show the part of the date the changes from one row to the next. Thus, if it is a 
monthly interval, only the month is shown not the hour or day. If it is a daily interval with an annual 
period, only the day number is shown. 

For periodic slots that are configured 
to Interpolate, the date represents an 
instant in time that corresponds to 
the end of a timestep. Thus, for a 
monthly interval, the dates are 24:00 
Dec 31, 24:00 Jan1, etc... Note, Feb 
29th is shown in this case but 
actually behaves as though it is 0:00 
March 1. 

The following figure shows 
screenshots of a periodic slot that has 
a Regular Interval and Monthly 
Interval. When a new periodic slot 
(Text Headers) is added to a data 
object, this is how they appear.The 
following table shows some sample 
results for the slots shown using the 
specified datetime.

Datetime A.Regular Interval - Lookup B. Regular Interval - Interpolate

24:00 January 13, 2001 10 14.2

24:00 February 23, 2003 20 28.2

24:00 October 21, 2009 100 106.8

A. Regular Interval - Lookup B. Regular Interval - Interpolate
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For Regular Intervals, the user cannot add or delete rows. The slot must be converted to an Irregular 
Interval first.

Irregular Intervals:  For 
Irregular Intervals, the 
timestep displayed is an 
instant in time. The 
screenshot shows the same 
slots above converted to an 
Irregular Interval. Because 
they have the same rows 
(displayed differently), the A 
slots would behave the same 
and the B slots would behave 
the same. 

The user can add or delete 
rows from periodic slots with 
an Irregular Interval using the 
Row menu. 

3.9.2 Headers

The user can create two 
different types of periodic 
slots: with text headers for the 
columns or with numeric headers for the columns.

3.9.2.1 Text headers

In this mode, the periodic slot simply contains columns of data that may or may not be related. There 
can be no interpolation across columns.To add a periodic slot with Text Headers to a data object:

1. Append a periodic slot by selecting Slots  Add Periodic Slot, Text Headers

2. If the columns are to be accessed using text, select Column  Set Column Label to add a text 
header to each of the columns. 

3.9.2.2 Numeric headers

Consider a periodic slot containing loss coefficients. The periodic slot may contain loss coefficients 
that vary not only with time, but also with flow rate in a reach. RiverWare could then identify which 
coefficient to use by indexing the table row using the current time step and the table columns using a 
flow rate. The user could specify as many columns as necessary to sufficiently describe the variation of 

A. Irregular Interval - Lookup B. Irregular Interval - Interpolate
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loss coefficients as a function of flow rate. The periodic slot’s Column Units would be configured to be 
flow, perhaps with units of 1000 cfs.

To add a periodic slot with Numeric Headers to a data object:

1. Append a periodic slot by selecting Slots  Add 
Periodic Slot, Numeric Headers.

2. Select View  Configure to configure the periodic slot

The dialog now has a Column Units section. This may be useful 
if the columns are indexed using numeric header values and the 
values have some physical (not simply descriptive) significance. 

The periodic slot can be used backwards to work from the table 
values and date outward to define a value associated with the 
column(s). For example, suppose the periodic slot defines the 
various pools or phases in a reservoir. The conservation pool 
may be defined as phase 1 with the first column containing pool 
elevations defining the conservation pool throughout the year. 
This first column would have a header of 1.0, meaning phase 1. 
The flood pool may be phase 2.0 with a second column using 2.0 
as its header. The surcharge pool may be phase 3.0, etc. Knowing 
the pool elevation at a given time, the periodic slot can be used to determine the current phase.   
Interpolating across columns, this outward lookup may determine that the current phase is 2.5 for a 
given pool elevation and date, meaning pool is halfway from the bottom of flood pool to the bottom of 
the surcharge pool.

3.9.3 Referencing Periodic Slots in RPL

In RPL, periodic slots are referenced using the Slot[E, E] syntax. Like other tables, 
this is a row by column reference. But, because it is a periodic slot, the row is a 
datetime: Slot[<Datetime>, E]. When referenced in RPL, the configuration of the slot 
will be used when accessing dates that are “between rows”. That is, it will either interpolate or look up 
depending on the slot’s configuration.

For periodic slots with text headers, the column specification is a text string matching a column or the 
zero-based column index. For periodic slots with numeric headers, the column specification is a 
numeric value with units. You can specify any number that falls within the min and max column values. 
That is, you don’t have to specify an exact column’s value, but can use numeric values that are 
“between columns” and it will linearly interpolate for you. For example, the following slot represents 
low flows that are based on reservoir levels. It is configured to lookup:
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In RPL, to reference this slot on January 15th for reservoir elevation 5002ft, the following would be 
used: 

Slot[@“January 15,2011”, 5002 ft] 

It would return:

12 cfs

5000 ft 5010 ft

Jan. 1  10 cfs 20 cfs

Feb 1 40 cfs 60 cfs

March 1 60 cfs 80 cfs
RiverWare Technical Documentation: Slots
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3.10 Scalar Slots

Scalar slots represent a single value. Configuration 
options include units and display format. Scalar slots 
are used only for input data parameters. The 
configuration of Scalar Slots is the same as the 
general slot configuration section HERE (Section 1.2.5). 

Some specific scalars and tables have 
a “Source” slot. When a slot has a 
source slot, the values are computed 
from other slot values. Thus, it 
becomes read-only and displays a 
cross hatch over the data. See 
screenshot. It also provides a note 
indicating the source slot used to 
compute the data. The source slot is 
typically set/un-set at beginning of 
run, so the user must initialize the run 
to see the read-only status.

Edit Field

Display value Add Description...

Configure
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3.11 Expression Slots - Scalar

A Scalar Slot with Expression can be created on a data 
object. To add a Scalar slot with expression select Slot  
Add Scalar Slot with Expression. This slot, similar to 
the Series Slot with Expression, is used to evaluate an 
expression that evaluates to only one value, i.e. timestep 
independent. Click HERE (Section 3.5) for more 
information on Series Slots with Expression as that 
information is valid here too. The difference is that the 
scalar expression slot does not have an Evaluation 
Range, it will evaluate for the single value only. Like the 
series expression slot, the user can configure when it 
evaluates. Use the Expression  Evaluation Time menu 
to choose. 

3.12 List Slots

A List Slot is used to store a collection of non-numeric data, typically 
a group of objects. Shown to the right is a sample Upstream 
Reservoirs List Slot. This slot contains the Reservoirs that are 
upstream of the given control point. It is used in the Regulation 
Discharge and Flood Control algorithm to specify the reservoir which 
contribute to the flow at this control point. The following options are 
available from the Edit menu, from the toolbar icons, and from the 
right click context menu:

On a List Slot that contains either Objects, Slots, Accounts, or Supplies, when the user clicks on either 
the Append Row, Insert Row Before, or Edit Row, a selector will open allowing the user to choose the 
appropriate items. 
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3.13 Mass Balance Summary

The Mass Balance Summary slot is a user-defined hierarchy of series slot collections used to check (i.e. 
sum) mass balance across many objects. The collections are themselves series slots representing the 
sum of the contained slots. These slots can be used within RPL expressions and any other place where 
series slots are used. 

There are two levels of within a Mass Balance Summary slot:

• Water Balance -- the sum of one or more Slot Sums. For example, a water balance might represent 
all water flowing in/out of the main channel or all flows in the groundwater.

• Slot Sum -- the sum of one or more series slots.   Slot sums are useful to summarize or classify differ-
ent slots. For example, a Slot Sum might represent all the seepage, evaporation, diversions or return 
flow slots. The sum is represented as either the positive or negative sense. Negative Slot Sums are 
subtracted from their containing Water Balance. Positive Slot Sums are added in the containing Water 
Balance. Only flow or volume (unit type) series slots having the model run timestep size can be used. 
References to RPL expression slots are supported for entities not represented by slots on simulation 
objects. 

The screenshot shows the icons for: (1) the Mass 
Balance Summary Slot, and (2) The Computed 
Mass Balance Slots (i.e. Water Balances and 
Slot Sums).

The Computed Mass Balance Slots are 
computed:

• On demand (by you) and/or 

• At the end of a run, immediately after the evaluation of post-run RPL expression slots. 

Also, a list of RPL expression slots to be evaluated after a Mass Balance Summary slot computation 
can be specified within the summary definition -- this can be used, for example, for annualization of 
mass balance summary results.
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The screenshot shows the dialog for 
a Mass Balance Summary Slot. 
Colors are associated with the three 
collection levels:

The three color buttons at the top of 
this dialog function as a “legend” for 
the three levels. Also, clicking on 
those buttons open the tree items in 
the list to the corresponding level. 
Also individual collection items can be opened and closed in the usual way -- by clicking on the tree 
controls.

Finally, the slots can be shown in any flow or volume units and plotted as needed.

3.13.1 Mass Balance Summary Slot Construction

Creating a Mass Balance Summary Slot:  A 
Mass Balance Summary Slot can be created 
on any data object from the menu by selecting 
the Add Mass Balance Summary operation.

The name of the new Mass Balance Slot can be 
edited in it’s dialog. When the typed name is 
not valid, the text in the name entry field is 
shown in red.
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Configuring a Mass Balance Summary Slot:  

Editing the configuration of a Mass Balance 
Summary Slot can be enabled or disabled. It is 
initially enabled on a newly created slot. Editing can 
be enabled or disabled with the following controls:

• The lock icon toggle button in the bottom left of the 
dialog. 

• The Enable editing item in the right-click context 
menu.

• The Enable editing item in the Edit menu.

Right-clicking in the list outside of any defined items 
(e.g. when the list is empty) shows a simple context 
menu including the Add Water Balance operation. 

The buttons along the bottom of the dialog are also 
context sensitive -- their operation and enabledness 
depends on the selection within the slot list. When no items are selected, the New button also adds a 
water balance to the list.

When new Water Balances or Slot Sums are 
created, they are given a unique default name. The 
name can be edited “inline” by double-clicking on 
the name.
RiverWare Technical Documentation: Slots
Revised: 4/27/12



70
 

Types of Slots
Mass Balance Summary

70
Slot Sums can be added to Water Balances, and Slot References can be added to Slot Sums using 
the Add context menu operation or the bottom context buttons.

When adding Slots, the slot selector dialog is 
shown. This will allow the selection of only series 
slots. The slot selector’s unit type filter will be 
shown, initialized to “Flow”. It is also valid to 
select “Volume” slots which represent a non-static 
volume entity -- i.e. those which can be converted 
to “Flow” by dividing its value by the timestep 
interval (i.e. volume per time). (The computed 
results will be strange if a static volume slot, such 
as Reservoir Storage, is selected).
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The following table illustrates the operations provided by the first several buttons, as a function of the 
selected item or items. Tooltips on these buttons provide additional information.

The New / Add and Paste operations are enabled only for single-
item selections. The Delete / Remove and Copy operations are 
enabled on single or multiple selections when all selected items are 
at the same level. The enabledness of the Paste operation depends 
also on the type of items (Water Balances, Slot Sums, or Slot 
References) in the clipboard. You must confirm Delete / Remove 
operations.

The up and down arrows move the selected items up or down within the set of “sibling” items. They are 
enabled only when the selected items are all at the same level.

The  and  buttons affect the Slot Sums within the set of selected items. When the mass 
balance summary is computed, the values of “positive” Slot Sums are added to the containing 
Water Balance; the values of “negative” Slot Sums are subtracted.
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RPL Expressions for Other Slots:   For any value not provided as a RiverWare slot, you will need to 
define and refer to a RPL expression slot. Here is an example of the inclusion of a “change in storage” 
expression slot from the previous to the current timestep.
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3.13.2 Mass Balance Summary Internal Display Operations

The Mass Balance Summary Slot dialog 
shows a single timestep value of all contained 
series slots. 

Note: All Water Balances, Slot Sums and 
series slot references must have the same 
timestep size as the model run. Water 
Balances and Slot Sums are computed for 
the model run interval (start to finish 
timesteps).

Units:  Series values can be displayed in any Flow or 
Volume units in this dialog. Volume values are 
converted to flows by dividing by the timestep 
interval. 

The individual settings for Flow and for Volume units 
are separately retained. That is, clicking the Flow and 
Volume toggle button switches between the last 
selected unit for those two unit types.

The selected unit type and unit is both a display 
setting and a configuration setting; when the mass 
balance summary is computed, the computed slots are 
reconfigured with these units. 

Note: When the computed results (Water Balances 
and Slot Sums) are referred to by RPL expressions, 
the units must work correctly or an error will be 
issued. Unit type incompatibilities will be reported by the RPL expression evaluation 
mechanism in the usual way.
RiverWare Technical Documentation: Slots
Revised: 4/27/12



74
 

Types of Slots
Mass Balance Summary

74
Tree Display:  As previously mentioned, the level “legend” buttons function to open the entire tree to 
the indicated level. Of course, individual tree items can be opened or closed by clicking on the standard 
tree controls.

The View menu provides operations which effect data display 
within this dialog.

Show Column: Units:   The units column in the slot list can be 
hidden. But, if slots having different unit types (other than flow 
and volume) are added to the list, units are unconditionally 
shown and the option to hide the units column is disabled.

Clicking the
Water Balances button

Clicking the
Slot Sums button

Clicking the
Slots button
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Show Values:  You may want to hide values at any of the levels, so that only comparable values (at the 
same level) are displayed. The three Show Series Values toggles in the View menus are used to show/
hide the numeric values as illustrated on the following screenshot.

3.13.3 Mass Balance Summary External Display Operations

From the Open Mass Balance Summary Slot dialog, you can:

• Show selected slots in an open slot dialog.

• Show slots in a new SCT or in the single open SCT. You can show either the visible (in the tree), or 
only the selected slots.

• Plot the selected slots.

• Copy selected slots, e.g. to an Output Device or to the Snapshot Manager.

These options are described in the following sections:

Show Computed Slots in an Open Slot Dialog:  As currently implemented, Water Balances are 
generated as aggregate series slots and each of the Water Balance’s Slot Sums are generated as series 
RiverWare Technical Documentation: Slots
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slot columns on that aggregate. Use the Open Slots... context menu to show the slot dialog for the 
selected component (editing disabled). 

Note: There is currently no indication of the Slot Sums’ “sense” being positive or negative. 

Values are displayed with a crosshatch indicating that they are “read-only” (non-editable). Notice, in 
the image above, the not-quite-zero value in the “Value” line edit field from the single selected cell 
(upper left cell) -- this sort of value will be typical of actual computed Water Balance values (due to 
convergence). Enabling the display of the selection statistics (from the View menu) and selecting the 
first column provides a convenient way to determine whether or not the whole Water Balance series is 
zero.
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Show Slots in an SCT:  Computed 
summary and referenced slots can be 
shown in an SCT. If a single SCT is 
open, slots from the Mass Balance 
Summary dialog can be added to that 
SCT (the SCT must have the same 
timestep size as the model run).

The File menu’s Show Visible Slots in 
New SCT shows all slot items current 
visible in the slot list (i.e. excluding 
those hidden under a closed tree 
branch).

Note: Water Balance and Slot Sum slots are shown with the values and units set at the time of 
the most recent mass balance computation -- i.e. not necessarily the current unit setting in the 
Open Mass Balance Summary Slot dialog. If referenced slots are including in the “show in 
SCT” operation, they will be shown with their currently configured (or “active”) units. And 
if they are editable slots, they will be editable in the SCT. (Notice the rows in the image 
above which are not cross-hatched -- those values are directly editable).
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Plot Slots:  Computed summary and 
referenced slots can be plotted in a 
single plot. Those operations are 
visible in the menus shown in the 
prior section. The note above 
regarding the active units of 
computed and referenced slots applies 
also to Plots -- i.e. the units used will 
not necessarily be those of the current 
settings in the Open Mass Balance 
Summary slot dialog.

Note: All values are plotted in their 
positive (actual) sense -- values in 
negated Slot Sums are not shown 
as negated values. 

Copy Slots:  Computed summary and 
referenced slots can be copied to the 
RiverWare Slot Clipboard. From 
there, they can be pasted into various 
slot lists in RiverWare, including the 
general Output Device slot list and 
the Snapshot Manager slot list. 

Examining the Mass Balance Summary Slot’s Series:  The Mass Balance Summary Slot is itself a 
series slot (contained on a data object) and can be examined by clicking on the Mass Balance Summary 
Slot icon button at the top of the dialog. (In a sense, a Mass Balance Summary Slot has two different 
“open slot” dialogs).
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In the plot above, notice how all of the values represented on the vertical axis are zero (to a precision of 
five fractional decimal digits), in this example.

3.13.4 Dependent RPL Expression Slot Support

Mass Balance Summaries are designed in such a way that intermediate and final sum results (Slot Sums 
and Water Balances) are usable for custom user calculations implemented in RPL Expression Slots, 
such as annualization of values. In a run, the mass balance summary is computed after RPL Expression 
slots. To allow RPL expression slots to reference mass balance summary data, the Dependent 
Expression Slot List in a Mass Balance Summary is evaluated, in order, once, after each Mass 
Balance Summary is computed.

Dependent Expression Slot results will generally be incomplete when computing a Mass Balance 
Summary if the RPL Expression Slots in the list depends on sums from multiple mass balance 
summaries. The following provisions address this problem:
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• The automatic “end-of-run” mass balance computations are 
performed in this order:

1. The RPL Expression slots in the Dependent Expression 
Slot Lists in ALL Mass Balance Summaries are cleared. 

2. All Mass Balance Summaries are computed.

3. The RPL Expression slots in the Dependent Expression 
Slot Lists in ALL Mass Balance Summaries are 
evaluated.

• In addition, in the File menu, there is a Compute All Summa-
ries option that perform this model-wide computation (the 
three steps in the prior item)

The Dependent Expression Slot panel 
at the bottom of the Open Mass 
Balance Summary Slot dialog 
implements editing and display 
operations similar to those of the 
main slot list.

Note: If the dependent Expression 
Slots use a different from the 
model’s run timestep, they can’t 
be displayed in the same SCT as 
the computed summary slots and 
slot references.

Clicking the Add button opens the 
slot selector, initialized with Has 
RPL Expression and Unit Type 
(“Flow”) filters on by default.

3.13.5 Mass Balance Summary 
Computation

When computed, the timestep size 
and timestep range of each of the 
Mass Balance Summary and Slot 
Sums are set to the step size and 
range of the run controller. The unit 
type and configured display units are 
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set to those specified. For each timestep in the run time range, any of the contained slots having a valid 
value at that timestep contributes that value to the Slot Sum or Water Balance’s value at that timestep. 
NaNs are ignored (effectively zero). The computed slots are set to be “read-only”.

Limitations of the current Mass Balance Summary Computation:

• No “routed terms”. A timestep offset cannot be applied to any slot reference within a Slot Sum, or to 
any Slot Sum within a Water Balance.

• No knowledge of “static volumes”. The mechanism unconditionally converts all volumes to flows by 
dividing the volume by the timestep size (for each timestep). A RPL implementation of the “change in 
storage” calculation can be seen HERE (RPL Expressions for Other Slots:).

Mass Balance Summary Computations are performed in these ways:

• By clicking the “Recompute” button in the Open Mass Balance Summary Slot dialog.

• By selecting the “Compute All Summaries” operation in the “File” menu of that dialog.

• Automatically, at the end of a run, immediately after the “end-of-run” RPL Expression Slots evalua-
tion. This is performed unconditionally.

As a tool for debugging and testing Mass Balance Summary implementations (including user 
definitions), operations to clear an individual Mass Balance Summary, and all Mass Balance 
Summaries (including Dependent Expression Slots) is provided in the File menu.

3.13.6 Persistence

All Mass Balance Summary configuration information is stored on the Mass Balance Summary Slot. 
This is applied both in the RiverWare model file and in Export SimObj (data object) files.

A Mass Balance Summary Slot’s computed slots are created as (effectively) invisible slots on the same 
data object. They do show up in the slot selector!

A Mass Balance Summary Slot’s configuration can also be saved to, and read from a file using Export 
and Import operations in File menu.
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4. DateTime Values in Slots

In addition to the standard unit types (Flow, Length, Volume, etc...) that can be configured on slots on 
data objects. It is now possible to add slots that have values in the slot that represents a DateTime. This 
is possible by configuring the slot to have a DateTime unit type. Following is a walk through describing 
how to add a slot with a DateTime value. Following that is a description of each of the date times and a 
description of how to use the values in RPL.

4.1 Walkthrough: Adding a Slot with DateTime Values to a Data Object

To introduce how DateTime Values exist on RiverWare Slots, 
this section walks the user through the process of creating a 
Series Slot with DateTime value on a Data Object.

STEP 1. Create a Data Object and Add a Series Slot, or 
any of the following types of Slots. All of the following 
support DateTime values:

• Series Slot

• AggSeries Slot

• Table Slot

• Scalar Slot

STEP 2. From the Open Object Dialog, double click on 
your new Series Slot to show the Open Series Slot dialog.

STEP 3. From the Open Series Slot’s View menu, select 
Configure to open the Series Slot Configuration dialog box...
RiverWare Technical Documentation: Slots
Revised: 4/27/12



83
 

DateTime Values in Slots
Walkthrough: Adding a Slot with DateTime Values to a Data Object

83
STEP 4. From the Series Slot Configuration dialog 
box, select the last item from the Unit Type option menu: 
DateTime.

The “DateTime” Unit Type, and the eight supported 
DateTime User Units are special in RiverWare. These 
selections cause the Slot’s values to be displayed and 
edited as DateTimes rather than as numeric values.

Unlike switching between ordinary Unit Types, switching 
to the “Date Time” Unit Type, and between the various 
DateTime “User Units” causes a change in the underlying 
Slot values. The user must confirm these changes with this 
popup dialog.

STEP 5. As a result of switching to the “DateTime” 
Unit Type, configuration properties associated with only 
numeric values are hidden (e.g. Min/Max values, Display 
Format, Convergence).

Notice the eight different “User Units” associated with 
the DateTime Unit Type. You can keep the default 
selection, “FullDateTime” ... Click OK.

Note:  AggSeries Slots and Table Slots support 
independent Numeric / DateTime configuration on each 
column.

STEP 6. As a result of selecting a “DateTime” unit, the Edit 
Date/Time Slot Values: area is added to the Open Slot dialog.

The entry and selection fields shown within the Edit Date/Time 
Slot Values: area depend on which DateTime “User Unit” 
selection was made. For the FullDateTime selection, two 
alternative entry modes are available, selectable with the checkbox 
on the left.

• Timestep Spinner -- for DateTimes on Timestep Boundaries. 
(first image).

• Unconstrained Date/Times -- for selection of any DateTime 
within the supported RiverWare date range. (second image) ....
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Try making different Cell Selections, hitting the Apply button and repeating these steps with different 
DateTime entry values.

Notice that the Value field at the top of the Open Slot 
dialog is disabled (not editable, and shown with a gray 
background). This field shows the actual internal 
numeric value associated with the selected cell’s 
DateTime value. 

Double-clicking on a cell assigns the cell’s value to the 
Edit Date/Time Slot Values: area.

When a range of cells is selected with the first and last 
cell having valid values, interpolated DateTimes can be 
assigned to the intervening cells. Try: Edit  Interpolate 
(not illustrated here).

Plotting of DateTime value series is also supported. (Hit 
the Plot icon button on the right side of the dialog). 
DateTime coordinates are not shown on the axes, but 
relative DateTime “magnitudes” can be discerned.

DateTime values which don’t conform to the Slot’s (or Slot column’s) configured DateTime “units” 
(Partial DateTime configuration) are shown with a yellow cell background. In addition, a value that is 
Not a Number (NaN) is shown with the syntax DT NaN.

4.2 Partial DateTime Editor

The Partial DateTime Editor in the Open Slot dialog also shows the applied DateTime. This page shows 
this dialog in standard numeric configuration and in the various Full and Partial DateTime 
configurations. The screenshots shown are for a Scalar slot but they are applicable to the other 
supported slots as well

DateTime User Unit Example Selection Mechanism

Full DateTime 18:00 May 16, 2007

Timestep Spinner or 

Unconstrained Date/Times

Month January

Month pulldown menu
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4.3 Access to DateTime values via RPL

RPL doesn’t directly support DateTime Slot values as DateTimes. All Slot values are handled as 
numeric values. Two Predefined RPL Functions are used to convert the Slot DateTime values to and 
from RPL DateTimes values. The following illustration demonstrates the use of the DateToNumber 
and NumberToDate Predefined functions. The following two sections provide more information about 
these predefined functions. 

Month and Day January 1st

Month and Day pulldown menu

Time of Year 24:00 Jan. 1

Hour, Month, Day pulldown menu

Day of Month 1st

Day of Month pulldown menu

Time of Month 24:00 1st

Hour and Day of Month pulldown menu

Time of Day 24:00

Hour pulldown menu

Year 2000

Year Spinner

DateTime User Unit Example Selection Mechanism
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The following links will take you to the appropriate documentation

• DateToNumber - This function converts a DateTime to the corresponding number. Click HERE (RPLPre-

definedFunctions.pdf, Section 23) for more information.

• NumberToDate - This function converts a number to a corresponding DateTime. Click HERE (RPLPre-

definedFunctions.pdf, Section 114) for more information
RiverWare Technical Documentation: Slots
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5. Notes on Series Slots

5.1 Introduction

Annotation of series slots using “Notes” allows the user to comment on data in a RiverWare model. The 
modeler may choose to document certain characteristics of input data such as filled values, storm 
events, etc. A run model saved with its results may include notes calling attention to certain operations, 
decisions, outcomes, etc. Other possible applications of this annotation functionality can be imagined. 
Notes are for documentation purposes; they do not affect the solution and they cannot be accessed (read 
or assigned) via RPL. In general, notes are available for all types of series (Series, Multi, Agg, Table 
Series, Series with Expression) and can be edited via the Open Slot dialogs, the SCT, and the Edit 
Account dialogs.

Notes are short text strings that are associated with one or more timesteps. Each note belongs to a “Note 
Group”. Each Note Group contains a list of associated slots and the timestep(s) to which they apply

The “Note Group Manager” utility dialog facilitates creation and management of Note Groups. The 
display icon for each group can be assigned a color.

Currently notes can be imported and exported using old-style (non-direct-to-database) DMI 
functionality. Notes can be imported directly to a series slot through the slot edit dialog’s file menu but 
the export functionality on the same menu does not support notes.

Note: Support for text Notes on series slot timesteps (“Annotations” or just “Notes”) was
redesigned in RiverWare 5.2. Notes are still organized within Note Groups, but notes are
now directly applied to individual series slot timesteps rather than by associating their
containing Note Groups with whole series slots. Additionally, multiple notes can be
associated with a timestep on an individual series slot.

5.1.1 Notes

A Note is a text string that is associated with a series slot at a timestep 
and each note is associated with a Note Group. A Note has the 
following properties:

1. Note text: The text string that makes up the Note.

2. Note group membership: A note belongs to exactly one Note Group.
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3. Slots and timesteps: A note has one or more series slots at specified timesteps

5.1.2 Note Groups

A Note Group is composed of three properties:

1. Name: a name is generally provided by the user.

2. Icon Color: A note group has one of eight basic 
colors.

3. Set of Notes: A Note Group has a set of one or 
more text Notes. 

If the user wishes to change the note, the user does this 
in one location the Note Group Manager, with the 
changes propagating to all slots associated with the 
Note Group as described HERE (Section 5.4.2).

5.2 Display and Editing of Notes

Note text can be seen and reviewed in the series slot dialogs. In the 
series slot dialogs (for Series Slots, Agg Series Slots, Multi Slots, Table 
Series Slots and Edit Account dialogs), the presence of a note is shown 
by a small icon to the left of the value. The color of the icon indicates 
the color of the note’s Note Group. Mousing over the icon displays a 
tool tip with the Note’s text.

Cells having more than one note have a special icon suggesting one 
note stacked on the other. The tool tip lists each note, one per line. See 
image to the right.That icon is always yellow and does not reflect the 
color of any of the corresponding Note Groups.
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The note text can be shown in a 
separate column using the View p 

[x] Show Notes Column toggle 

menu item. If the Notes Column is 
visible and the open slot belongs to 
one and only one Note Group, a 
new note can be created by simply 
typing in the Notes Column. The 
Note will be created as a member of 
the slot’s Note Group. 

When one or more notes exist 
on a particular Slot/Timestep, 
the context menu (right-click) 
on the cell includes a submenu 
for each note. See the image 
below. The title of the 
submenu shows the Note 
Group icon and the Note Text. 
The submenu contains three 
operations:

• Copy Note: The Copy Note 
menu item copies a Note 
reference to the Note Copy Buffer. In the example shown to the right, the “Max Flow in Run” note 
would be copied to the buffer. The note can then be pasted in one or more cells using the Paste Note 
operations.

• Edit Note: The Edit Note... menu item shows the Note Group Manager Dialog, with the indicated 
Note pre-selected. The user may change the note text, or move the note to a different Note Group 
(potentially having a different Note Group icon).

• Remove Note: The Remove Note menu item removes the indicated note from the selected Slot/
Timestep (only). This does not effect the appearance of the same note at other timesteps on the same 
Slot, or on any other Slot.
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The dialog can be scrolled to the timestep of a note 
on the Slot via the Note Navigation menu button. 
See the screenshot to the right Items in the Note 
Navigation menu having a bullet indicate that the 
timestep of the note matches that of the timestep 
spinner.

Holding down the Shift Key while selecting an 
item causes a Global Time Scroll (scrolling all 
open series-related dialogs to the corresponding 
timestep).

5.3 Creation of Notes

Following are three ways to create a note:

1. In an open series slot dialog, edit account dialog or SCT

• Right-click in a cell

• Select Add Note... from the context-sensitive pop-up menu. This will open the Note Group Manager 
which is described in detail HERE (Section 5.4).

• Choose or create a Note Group 

• Choose or create the Note text. 

• Choose the slots and timesteps to which the note should apply by clicking on the Add Entry Using 
Context button. This opens the Apply Notes to Slots dialog which is described HERE (Section 5.5). The 
slot and timestep from which this right-click operation began are selected.

• Change/add slots or timesteps (if necessary) and click Ok to associate the Note with the slot/timestep. 

2. From the main workspace:

• Choose the Utilities p Note Group Management... menu. This opens the Note Group Manager dia-
log as described HERE (Section 5.4)

• Choose or create a Note Group.

• Choose or create the Note text.

• Click the Add Slot Entries... button to open the Apply Notes to Slots dialog which is described HERE 

(Section 5.5).

• Click the Add Slots... button and choose the slots to which the note applies.

• Specify the timestep or range of timesteps to which the note applies.

3. To create a note based upon an existing note (copy/paste of note). In an open series slot dialog, edit 
account dialog or SCT

• Right-click in a cell that has the desired noted.

• Select the note from the context-sensitive menu and choose Copy Note.
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• Go to the destination slot and timestep and right-click in the cell. 

• Choose Paste Note: Name.

5.4 Note Group Manager Dialog

The Note Group Manager 
and supporting sub-dialogs 
are used to maintain the set 
of notes on series slots. 

This dialog is arranged 
vertically in three 
hierarchically defined 
panels as shown in the 
following figure: Note 
Groups, Notes, and Slots. 
The first two panels can 
show either a list or a combo 
box, controlled by the 
triangle arrow button in each 
panel. The combo boxes 
allow for the selection of a 
single item (Note Group or 
Note), or “All” items. 

The panels are used in a top 
to bottom order. First you 
select (highlight) one or 
more Note Groups. Then 
the member Notes are 
displayed in the Notes 
panel. Then you select one 
or more Notes in the Notes 
panel and the member slots 
and timesteps are displayed in the Slots panel.

Following is a description of these three panels.

5.4.1 Note Groups panel: 

The Note Groups panel shows all the defined Note Groups and supports three operations (buttons):

• Create Note Group...

• Edit Selected Group...

• Delete Selected Groups
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These buttons bring up dialogs for creating (define the name and icon color) or editing (changing the 
name and icon color), or confirming deletion of Note Groups as shown below:

5.4.2 Notes panel: 

For the selected Note Group in the above panel, the Notes panel shows the notes that are a member of 
that group. It supports three operations (buttons):

• Create Note...: Enter a new Note text and choose the Note Group to which it belongs.

• Edit Selected Note...: Edit existing Note text or change the Note Group to which it belongs.

• Delete Selected Notes...: Delete the selected Note after confirmation.

5.4.3 Slots: 

For the selected 
Note(s) in the middle 
panel, the Slots panel 
shows the slots and 
timesteps to which the 
note has been applied:

Both the Add Slot 
Entries... and Add 
Entry Using Context: Slot / Timestep context
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buttons bring up the Apply Notes to Slots dialog described in the next section. These differ only in the 
initial selections used in that dialog. The Add Entry Using Context button is available when the 
manager dialog is shown from the context of a particular slot and timestep, i.e. right clicking on a cell 
in a slot or SCT then choosing Add (or Edit) Note. The current context (Object.Slot and Timestep) is 
listed on the same line as the button.

5.5 Apply Note to Slots dialog

The Apply Note to Slots dialog allows the user to 
associate a particular note with one or more Slots at one 
or more contiguous timesteps.

The list of slots and the timestep selections are 
sometimes pre-selected, depending on how the Apply 
Note to Slots dialog is shown. These selections can be 
modified before creating the new Note/Slot/Timestep 
associations.

The Group and Note combo boxes can be modified to 
select a different note. Only one note can be selected at 
any one time.

Additional Slots can be added to the Slot List by 
clicking the “Add Slots...” button. This brings up the 
RiverWare Slot Selector.

Slots can be removed from the Slot List by selecting 
items in the list and clicking the “Remove Selected 
Slots” button. Doing so has no effect on any existing 
Note/Slot/Timestep associations.

In the Timesteps section, the user can choose one 
timestep or range of timesteps (continuous only) to 
which the note will apply.

The OK or Apply buttons are enabled only if the inputs 
specify a valid state representing Note/Slot/Timestep 
associations that are not yet existing. For one thing, all 
of the Slots in the Slot list must have the same timestep size. If enabled, the OK and Apply buttons 
create a Note/Slot/Timestep association for all of the Slots in the list (i.e. not just the selected Slot 
items). 

Status lines under the Slot List and above the bottom buttons indicate the state of the inputs. Examples 
of the various messages shown in the bottom status line are as follows. (The OK and Apply buttons are 
enabled only in the 4th example):

• No defined Note is selected.

• The Slot list is empty.
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• The Slot list includes Slots having different timestep sizes.

• Apply selected note to 6 Slot/Timesteps... [enabled state]

• The selected note has been applied to 6 Slot/Timesteps.

5.6 Collected Notes on Expression Slots

Collected notes are a special type of note associated with series expression slots (i.e. Series Slot with 
Expression). When the expression slot is evaluated, notes from the series slots referenced in its 
expression (“source” slots) are copied to corresponding timesteps in the expression slot. The source 
slots for providing notes are an accumulated list of the source slots referenced across the expression 
slot’s evaluations at all timesteps. The notes from the source slots are collected and copied once at the 
end of the expression slot’s evaluation. The collected notes are removed and re-collected each time the 
expression slot evaluates. In the context of a run, they are removed at the beginning of the run and 
collected at the end of the run, so if the run is paused or aborts in the middle, the collected notes will be 
absent.

The collection of notes for 
series with expressions is 
optional and is controlled on a 
model-wide basis by a 
parameter selection in the RPL 
Parameters dialog. This dialog 
is available from the RiverWare 
workspace under the Policy 
menu.

In the places where notes for 
series can be displayed (Series 
Slot, SCT and Notes Group 
Manager dialogs), collected notes are differentiated by having a C in their icon. See the image below. 
The text of a collected note, where displayed in the notes column or in a tool tip when mousing over a 
note icon, will show the text of the note followed by the source slot name in parentheses. 

Note: Note that if a note is propagated up through a number of expression slots, the slot
where the note originated is maintained as the source slot for the note even though one
expression slot may be picking it up from another expression slot that referred to the source
slot. 

The context menu (right-click) on a cell for a collected note in the series slot and SCT dialogs will have 
an additional menu entry showing the source slot of the collected note. Click the item to open the 
source slot’s dialog. If a source slot is deleted from the model, the collected notes that refer to that 
source slot will also be deleted.
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5.7 DMI I/O

Notes can be output from RiverWare slots to data files using “old-style” DMI’s (i.e. DMI’s 
parameterized to use an external program and a control file as opposed to direct-connect database 
DMI’s). The control file keyword used to specify notes is as follows:

slot_anno = true

The default value for slot_anno is false, meaning no Notes will be written.

A line in RiverWare time series format (for DMI import or from DMI export) containing a note will be 
formatted as:

<value> anno {Storm Events} {4.3 Inches}

where <value> will be a numeric value, “anno” is a keyword, Storm Events defines the Note Group to 
which the note belongs and 4.3 Inches is the note itself. The “<“ and “>” will not exist in actual output. 
The “{“ and “}” do exist, delimiting the Note Group name from the note text itself.

Note: In the external RiverWare time series format, only one Note will be supported at one
given timestep on any one SeriesSlot. That is, if a given SeriesSlot is a member of more
than one (say, two) Note Groups, and if both of those Note Groups have a Note at the same
timestep (say, 2-13-2007), then only ONE of those Notes will be preserved in the DMI
operation.
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